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1. INTRODUCTION 
Read&Write 9 GOLD is designed to provide help to computer users with reading and 
writing difficulties. It can read text aloud and help you construct words and sentences. It 
also has many other features, such as advanced spell checking, document scanning and 
Internet tools, to name but a few. 

This guide is designed to familiarize you with all aspects of the system. As well as learning 
how to use the many facilities offered in Read&Write 9 GOLD, you’ll also learn how to set 
up the system so that it’ll operate in exactly the way you want it to. 

This guide is split into the following four sections: 

• Basic Exercises – these exercises will help you learn all of the basic skills you need 
to set up and use the different Read&Write 9 GOLD facilities  

• Additional Exercises – these further exercises will help you learn additional skills 
that are not necessarily fundamental to the running of Read&Write 9 GOLD 

• Teacher’s Toolkit – these exercises are designed for use by teachers and trainers 
only. They provide instructions on how to use the Teacher’s Toolkit to set up the 
system for students and to monitor student activity and progress 

• PDF Accessibility Editor – these exercises show you how to use PDF Accessibility 
Editor in order to have PDF documents read in exactly the way you want. 
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 Basic Exercises 

2. GETTING STARTED  

In this section you’ll learn how to: 

• log into the system 

• understand the Read&Write 9 GOLD toolbar 

• position the Read&Write 9 GOLD toolbar 

• customize the toolbar. 

Exercise 1 Logging into the system 
1. Click on Start on the Windows desktop. Select All Programs, Read&Write 9, then 

Read&Write 9 again, as shown below: 

 
Figure 2-1 Read&Write 9 Menu 

Alternatively, you can double click on the Read&Write 9 shortcut on your Desktop. 

The Texthelp Login window is displayed (Figure 2-2). 

 
Figure 2-2 Login window 

User Group drop down list 

Login Name drop down list 

Password text box

 You may see the User setup wizard displayed instead of the Login window. This will 
depend on how your teacher or trainer has set up the system. This wizard will help 
you specify how you want Read&Write 9 GOLD to work for you. Follow each step in 
the wizard to customize your version of the software.  

2. Make sure that All Users is selected from the User Group drop down list and Default 
is selected from the Login Name drop down list. 

3. Click on the Login button. After a few seconds you see the Read&Write 9 GOLD 
toolbar (Figure 2-3) appear on screen. 

Exercise 2 Understanding the toolbar 
In this exercise, you’ll learn what each of the buttons on the Read&Write 9 GOLD toolbar 
does. 
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1. Look at the following table (Figure 2-3) and take note of what each button does. 

You’ll not be able to see all of the buttons listed in the table. If you’re using the default 
toolbar, you’ll only be able to see the buttons on the My Features toolbar. 

 For more information on the different types of toolbars, refer to Exercise 4 ‘Setting 
up toolbar display options’ on page 4. 

 

 
Spell Check button 

  
Word Prediction button 

  
Dictionary button 

  
Word Wizard button   

Show Homophones 
button 

 
Sounds Like 
(Homophone) button 

  
Hide Homophones 
button 

  
Calculator button 

  
Rewind Speech button   

Play Speech button 

  
Pause Speech button   

Forward Speech 
button 

  
Stop Speech button  

Screenshot Reader 
button 

  
Speech Maker button 

  
Daisy Reader button 

 
Pronunciation Tutor 
button 

  
Scan button 

  
Fact Finder button 

  
Fact Folder button 

  
Fact Mapper button 

 
Use the Translator 
button 

 
Launch PDFaloud 
button 

 
Screen Masking button 
 

  
Speech Input button 

  
Highlight yellow button 

 
Highlight blue button 

  
Highlight green button 

  
Highlight pink button 

  
Clear highlights button 

  
Collect highlights 
button 

  
Summary button 

  
Help button   

Change Toolbar button 
and Read & Write 
Menu button 

  
Undock the Toolbar 
button 

Figure 2-3 The Read&Write 9 GOLD toolbar 

You can also use hotkeys to access the facilities on the Read&Write 9 GOLD toolbar. 

 For more information on setting up and using hotkeys, refer to Exercise 4 ‘Setting up 
hotkeys’ on page 93. 

2. Click on the  drop down list to the right of the  button and make sure the 
Show tooltips on toolbar option is selected. You will know that it has been selected if 
you can see a check beside it: 
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3. Hover your mouse over the  button. You see the tooltip ‘Spell Check’. Hover your 

mouse over the  button. You see the tooltip ‘Dictionary’.  

From now on, if you have difficulty remembering what a button does, hover your 
mouse over it to see the associated tooltip. 

4. Click on the  drop down list to the right of the  button. You see a list of options 
that allow you to setup up how you want the Spell Check facility to work. 

 Anytime you want to set up a facility to suit your needs, you click on the  drop 
down list beside the appropriate button on the toolbar. 

 

 In future, anytime this guide asks you to click on the facility drop down list, for 

example, the  drop down list, you must click on the  button beside the 
appropriate button. 

Exercise 3 Positioning the toolbar 
You can position the toolbar anywhere on the screen. You can also dock it at the top or 
side of the screen so that it stays in one place. Let’s practice working with the toolbar. 

1. Click on the title bar of the toolbar and then drag and drop it onto any position on your 
screen. 

2. Click on the title bar of the toolbar again and then drag and drop it onto the very top of 
your screen. 

The toolbar is docked at the top of your screen. If you want to undock the toolbar, 

click on the  button. You can also drag and drop the toolbar to either side if you 
wish to dock the toolbar to the side of the screen.  

Exercise 4 Setting up toolbar display options 
Now that you’ve docked the toolbar, you can practice changing how it looks.  

1. Make sure the My Features toolbar is displayed, i.e. the default toolbar. To do this, 

hover your mouse over the  button on the toolbar. The tooltip informs you of 
which toolbar you are currently viewing. If it is not the My Features toolbar, click on 

the  drop down list and make sure the My Features option from the Current 
Toolbar sub-menu is selected. 

2. Click on the  drop down list again and select General Options.  

You see the Display tab of the General Options window (Figure 2-4). 
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Current toolbar

Toolbar buttons list box

Small icons without 
text radio button 

Select an icon set drop down list

Small icons with text  
radio button 

Figure 2-4 Display tab 

3. To customize the current toolbar option you selected in step 1, de-select the following 
check boxes in the Toolbar buttons list box: 

• Prediction 

• Get homophone suggestions. 
4. Select the Small icons with text radio button. 

5. Select the Fun option from the Select an icon set drop down list and then click on 
the OK button. 

The buttons on the toolbar change in appearance. Notice how you cannot see the 
Prediction and Homophones buttons. Now go back to the Display tab and return the 
toolbar to its original settings by completing the following steps: 

6. Click on the  drop down list again and select General Options. You see the 
Display tab of the General Options window (Figure 2-4). 

7. Make sure the following check boxes in the Toolbar buttons list box are selected: 

• Prediction 

• Get homophone suggestions. 

8. Select the Small icons without text radio button. 

9. Select the Professional option from the Select an icon set drop down list and then 
click on the OK button. 

There are five other toolbars available from the Current Toolbar menu. You can also 
use the Display tab to customize these to suit your needs. These toolbars are as 
follows: 

• All Features – all buttons on the toolbar are visible 

• Reading Features – only buttons associated with reading are displayed on the 
toolbar 
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• Writing Features – only buttons associated with writing are displayed on the 
toolbar 

• Research Features – only buttons associated with researching are displayed on 
the toolbar 

• Study Skills – only buttons associated with Study Skills are displayed on the 
toolbar. 

10. Click on the  button repeatedly and notice how the toolbar changes between 
each of the six available toolbars. 
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3. READING TEXT 

In this section you’ll learn how to: 

• select a system voice 

• instruct the system to read letters, words and sentences as you type 

• set up screen reading 

• set up speech highlighting and use the speech buttons 

• specify how you would like words pronounced 

• read text on web pages 

• read text on images 

• read Dragon Recognized Text 

• convert text into sound files 

• read a PDF file using PDFaloud. 

Exercise 1 Selecting a system voice 
Before you begin this section, type the following text into a blank Microsoft Word 
document: 

After the crop duster's old pickup pulled away and its tail lights disappeared down 
the road, I sat on my suitcase and looked around me. It was dead quiet and empty 
black, except for the starlight. 

 Remember to check that your speakers are switched on before you continue with this 
section. 

1. Click on the  drop down list on the toolbar and make sure the Read by paragraph 
option is selected. You will know that it has been selected if you can see a dot beside 
it: 

 
2. Place the cursor anywhere in the paragraph you’ve just typed and then click on the 

 button on the toolbar to hear the text read aloud. Click on the  button to stop 
the system from reading the text. 

3. Click on the  drop down list on the toolbar and select Speech Options. 

You see the Speech tab of the Speech Options window (Figure 3-1). 
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Select a voice
drop down list

Search button 

Pitch track bar 

Speed track bar

Volume track bar 

Test voice button 

Figure 3-1 Speech tab 

4. Select ‘Texthelp Jane US’ or ‘Texthelp Jack US’ from the Select a voice drop down 
list. 

5. Drag and drop the track bars to the following settings: 

• Pitch – 54% 

• Speed – 45% 

• Volume – 60%. 

6. Click on the Test voice button to hear the new voice read aloud. 

7. If you’re not happy with the voice, change the settings you’ve just selected in steps 4 
and 5. 

8. Click on the OK button. 

Exercise 2 Instructing the system to read parts of a paragraph 
In this exercise you’ll learn how to set up the system to read letters and words as you 
type. 

1. Click on the  drop down list on the toolbar and select Speech Options. 

You see the Speech tab of the Speech Options window. Click on the Autoread tab 
(Figure 3-2). 
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I would like to use speak
as I type check box

Speaking options
 check boxes

I would like to use screen
reading check box

Screen reading
check boxes

Figure 3-2 Autoread tab 

2. Select the I would like to use speak as I type check box and then select the Speak 
on each letter check box. Also make sure the Speak on each word check box is 
selected. 

3. Click on the OK button to save the settings and to close the Speech Options window. 

4. Place your cursor after the text you’ve already typed and then type the following text 
slowly. As you do so, listen to each letter and word read aloud. 

This was a first for me. I had never felt so alone. 

5. Click on the  drop down list on the toolbar and de-select the Speak As I Type 
option to stop the system from reading each letter and word as you type. 

Exercise 3 Setting up screen reading 
In this exercise you’ll learn how to set up and use screen reading. The screen reading 
facility can come in useful if you have trouble reading or understanding items on the 
screen, e.g. menu options and button labels.  

1. Click on the  drop down list on the toolbar and select Speech Options. 

You see the Speech tab of the Speech Options window displayed. Click on the 
Autoread tab (Figure 3-2). 

2. Select the I would like to use screen reading check box. 

3. Make sure the Buttons and Menus check boxes are selected from the list at the 
bottom of the screen and then click on the OK button to close the Speech Options 
window. 

4. Hover your mouse over the  button on the toolbar. You hear the system say 
‘Play’. 
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5. Click on the  drop down list and hover your mouse over Read by word and then 
Read by sentence. You hear each menu option read aloud. 

6. De-select the Use Screen Reading option to disable this facility. 

Exercise 4 Setting up speech highlighting and using the speech buttons 
In this exercise you’ll learn how to specify how you want the system to highlight text as it 
is read aloud and to use the Speech buttons on the toolbar. 

1. Click on the  drop down list on the toolbar and select Speech Options. 

You see the Speech tab of the Speech Options window displayed. Click on the 
Highlight tab (Figure 3-3). 

 

Speak with highlighting in
document radio button

Speak using one word
display radio button

Options section

Figure 3-3 Highlight tab 

2. Select the Speak using one word display radio button. 

3. Click on the Word color button and select a red color from the color palette and then 
click on the Sentence color button and select a green option from the color palette. 

4. Select 50 from the Font size drop down list. 

5. The ‘Speak using one word display’ method works better if the system voice is 
slower. Click on the Speech tab. 

6. Drag and drop the Speed track bar to 30%. 

7. Click on the OK button to save the settings and to close the Speech Options window.  

8. Click on the  drop down list on the toolbar and make sure Read by sentence is 
selected. 

9. Place your cursor anywhere on the following sentence in your document and then 

click on the  button: 

It was dead quiet and empty black, except for the starlight. 
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You see each word in the sentence displayed in a popup window as it is read aloud. 
An example of this window is shown below: 

 
10. Open the Highlight tab of the Speech Options window again and select the Speak 

with highlighting in document radio button. 

11. Select Violet background with bright green block highlighting from the drop down list 
displayed in the Options section. 

12. Click on the Speech tab (Figure 3-1). 

13. Drag and drop the Speed track bar to 50%. 

14. Click on the OK button to save the settings and to close the Speech Options window. 

15. Click on the  drop down list on the toolbar and select Automatically read next 
block of text to ensure that Read&Write 9 GOLD will continue to read the next block 
of text when it has finished reading the current one. 

16. Place your cursor anywhere on the following sentence in your document and then 

click on the  button: 

After the crop duster's old pickup pulled away and its tail lights disappeared 
down the road, I sat on my suitcase and looked around me. 
Note how the sentence is highlighted using a violet color and each word in the 
sentence is highlighted in pale green as it is read aloud. Also note how the system 
continues reading the next sentence once it has finished reading the selected one. 

The other highlighting options are as follows: 

• Speak with highlighting in Text Reader – the selected text will be displayed 
and read from the Text Reader Window 

• Speak with no visual display – the selected text will be read aloud without 
highlighting. 

Exercise 5 Changing how words are pronounced 
In this exercise you’ll learn how to change the way that the system pronounces certain 
words. This is useful if you occasionally type words that are not commonly used and may 
therefore be difficult for the system to pronounce.  

1. Click on the  drop down list on the toolbar and select Speech Options. 

You see the Speech tab of the Speech Options window. Click on the Say Like tab 
(Figure 3-4). 
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Pronounce this 
text box Pronunciation 

list box

Like this text box 

Figure 3-4 Say Like tab 

2. Type the word Ute into the Pronounce this text box and then click on the  button 
beside the text box to hear this word read aloud.  

3. Type Yuut into the Like this text box and then click on the  button beside the text 
box to hear the new pronunciation read aloud.  

4. Click on the Save button to add the word to the Pronunciation list box and then click 
on the OK button to close the Speech Options window. Once you’ve added the word 
to the Pronunciation list box, the word will be pronounced correctly. 

Exercise 6 Reading text on web pages 
In this exercise you’ll learn how to use Read&Write 9 GOLD to read aloud text on web 
pages.  

1. Click on the  drop down list on the toolbar and make sure the Web Highlighting 
option has a check beside it as shown below. A check means that it is enabled. 

 
2. Open your Internet browser window and type www.texthelp.com into the Address 

field to display the Texthelp homepage. 

3. Hover your mouse over an area of text until you see it highlighted. You will hear the 
text read aloud.  

 Read&Write 9 GOLD will read aloud any of the text that is under your mouse. 
 

 Alternatively, if you want to read text in the Firefox browser (3.0), select the text and 

click on the  button. Click on Yes when prompted to install the plug-in. After the 
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plug-in has been installed simply make a selection and click on the  button to 
have the text read with dual colored highlighting. 

4. Leave the Texthelp homepage open to complete the next exercise.  

Exercise 7 Reading text on images 
In this exercise you’ll learn how to use Screenshot Reader to read aloud text used in 
images.  

 The Screenshot Reader can be used with inaccessible Flash and locked PDF 
documents as well as images. 

1. Make sure the Texthelp homepage is still displayed in your Internet browser window. 

2. Click on the  button. Your cursor now looks like this: . 

3. Select the following logo (Figure 3-5): 

 
Figure 3-5 Texthelp logo 

Read&Write 9 GOLD reads the text aloud in a separate window (Figure 3-6). 

 
Figure 3-6 Screenshot Reader window 

4. Click on the  drop down list and select Screenshot Reading Options.  

You see the Screenshot Reader Options window displayed (Figure 3-7). 
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Figure 3-7 Screenshot Reader Options window 

5. Select the Use outline highlighting radio button. 

6. Select Green from the Outline color drop down list. 

7. Click on the OK button. 

8. Click on the  button. Your cursor now looks like this: . 

9. Select the following logo again (Figure 3-8): 

 
Figure 3-8 Texthelp logo 

You can see that the text is highlighted using the settings you have just selected 
(Figure 3-9). 

 
Figure 3-9 Screenshot Reader window 

10. Click on the  drop down list and select Screenshot to MS Word. 

11. Click on the  button. Your cursor now looks like this: . 

12. Select the Texthelp logo again, as shown in Figure 3-8. 

The text is displayed in a new Microsoft Word document. 

13. Click on the  button to read the text aloud. 
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 You can also use the other Read&Write 9 GOLD facilities on text imported into 
Microsoft Word. 

14. Close the Microsoft Word document when you have finished. You do not need to 
save the document. 

Exercise 8 Reading Dragon Recognized Text 
In this exercise you’ll learn how to read aloud text recognized by Dragon to ensure that 
Dragon has recognized exactly what you wanted to say. 

Dragon, the speech recognition software, works in a similar way to the Speech Input 
facility as it allows you to create documents by simply talking into a microphone. 
Read&Write 9 GOLD can read aloud text recognized by Dragon, which is useful if you 
want to make sure that Dragon has recognized exactly what you wanted to say. 

 You must have Dragon Naturally Speaking installed in order to complete this 
exercise. 

1. Make sure that Dragon is running and close all open documents. 

2. Click on the  drop down list on the Read&Write 9 GOLD toolbar and select Speak 
Dragon Recognized text. 

3. Open a new document in Dragon. 

4. Speak the following into your new document: 

After the crop duster's old pickup pulled away and its tail lights disappeared 
down the road, I sat on my suitcase and looked around me. It was dead quiet 
and empty black, except for the starlight. 

Notice how Read&Write 9 GOLD reads the text aloud. 

Exercise 9 Converting text into sound files 
In this exercise you’ll learn how to convert text in documents into sound files, using the 
Speech Maker facility. 

1. Highlight the following text in your document: 

After the crop duster's old pickup pulled away and its tail lights disappeared 
down the road, I sat on my suitcase and looked around me. It was dead quiet 
and empty black, except for the starlight. 

2. Click on the  button on the toolbar.  

The highlighted text is displayed in the first window of the Speech Maker facility. 

3. Click on the Next button. You see the second window in the Speech Maker facility 
(Figure 3-10). 
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Pitch, Speed and 
Volume track bars 

Selected Voice 
drop down list 

Test voice button 

Figure 3-10 Voice settings window 

4. Select ‘Texthelp Jane US’ or ‘Texthelp Jack US’ from the Selected Voice drop down 
list and then drag and drop the following track bars: 

• Speed – drag this track bar to 0.3 

• Volume – drag this track bar to 80%. 

5. Click on the  button to test the voice. If you decide that you don’t like this voice, 
select another one from the Selected Voice drop down list and adjust the track bars 
until you are happy.  

6. Once you have selected a suitable voice, click on the Next button.  

You see the third window in the Speech Maker facility (Figure 3-11). 

 

Save As button 

WAV radio button

Figure 3-11 File Settings window 

7. Click on the Save As button to display the Save As window. 

8. Browse to the folder in the directory in which you want to save the sound file, type a 
name for the file in the File name text box, and then click on the Save button.  

9. Select the WAV sound file format radio button and then click on the Finish button to 
create the new sound file. 

10. Browse to the directory where you saved the sound file and open it to hear the sound 
file you’ve just created. You hear the text you highlighted in step 1 read aloud. 
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11. Click on the  button until you can see the My Features toolbar. The tooltip for 
this button will help you identify the toolbar you need. 

Once you’ve selected the settings which best suit you, it will not be necessary to repeat 

steps 3 to 9. Instead, click on the  drop down list on the toolbar and select Create file 
using last saved settings. You’ll know this has been selected if you see a check beside it. 

Now when you select text and click on the  button, you’ll automatically see the Save 
As window.  

If you later decide that you want to change the settings, click on the  drop down list on 
the toolbar and make sure Create file using last saved settings is de-selected. 

Exercise 10 Reading a PDF file using PDFaloud 
PDFaloud is designed to provide help to Adobe Acrobat users with reading difficulties. It 
does this by reading text aloud from PDF documents, using the Speech Control facility. 

You can control how you want to hear the text read aloud by adjusting the speech and the 
pronunciation settings. 

1. Click on the  button on the toolbar and open a PDF file when prompted by the 
system. 

 The Texthelp PDF Viewer opens and the PDFaloud toolbar is displayed (Figure 
3-12).  

 

 
 

 

 

Figure 3-12 PDFaloud toolbar 

Click-and-
Speak button 

Click-and-speak options 
button 

Speech buttons

2. Click on the  button on the toolbar. PDFaloud starts to read aloud the document. 

3. Click on the  button on the toolbar to stop the system from reading the document. 

4. Click on the Options button on the toolbar. PDFaloud is set to have Continuous 
Reading. You’ll know it has been selected if you see a check beside it, as shown 
below:  

 
5. Turn off the Continuous Reading by de-selecting it. 
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6. Click on the  drop down list and select By sentence. This means the Speak facility 
will read by sentence. 

7. Click on the  button on the toolbar and then click anywhere in the sentence you 
want to hear read aloud. 

PDFaloud reads aloud the selected sentence.  

8. Click on the  drop down list and select By word and then click on the  button. 

9. Click anywhere in the word you want to hear read aloud. 

PDFaloud reads aloud the selected word. 

10. Click on the  button on the toolbar again to disable the Click-and-Speak facility. 
PDFaloud will no longer read aloud text when you click on the document. 

11. You can also change PDFaloud speech and pronunciation settings. Click on the 
Options button on the toolbar and select Speech Options. You see the PDFaloud 
Speech Options window displayed (Figure 3-13). 

The Pronunciation Options allow you to change the way that the system pronounces 
certain words. This is useful if you occasionally type words that are not commonly 
used and may therefore be difficult for the system to pronounce. You can set up 
Pronunciation Options in a similar way to using the Say Like tab. 

 For information on using the Say Like tab, refer to Exercise 5 ‘Changing how words 
are pronounced’ on page 11. 

 
Figure 3-13 PDFaloud Speech Options window 

12. Select the Hover highlighting radio button. 

13. Select Yellow from the Highlight color drop down list. 

14. Select Blue from the Background color drop down list and then click on the OK 
button. 

15. Hover your mouse over an area of text. You see the text highlighted and read aloud. 
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16. Once you have finished using hover highlighting, access the PDFaloud Speech 
Options window again (Figure 3-13) and select the Click and speak radio button. 

 



 

4. SPELL CHECKING  

In this section you’ll learn how to: 

• use the Spell Checker and set up general spelling options 

• use the Auto Correct file and spell check as you type 

• add words to the custom dictionary 

• review spellings 

• add a phonetic replacement. 

Type the following text into a blank Microsoft Word document: 

 There are deliberate spelling mistakes in the text that you must enter letter for letter. 
They are underlined. You do not need to underline these misspelled words in your 
document. 

After the crop duster's old pickup puled away and its tail lights disappeered down 
the road towards Bannack, I sat on my suitcase and looked arround me. It was dead 
quiet and empty black, except for the Montana starlight arround me.  

Exercise 1 Using the Spell Checker and setting up general spelling 
options 

In this exercise you’ll learn how to set up general spelling options and use the Spell 
Checker. 

1. Click on the  button on the toolbar. You see the Spelling Helper window displayed 
(Figure 4-1). 

 

Original word text box

Word list box
Move to next error 
after solving this one 
check box  

Figure 4-1 Spelling Helper window 

The first misspelled word in your document is highlighted in the Original word text 
box. 
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2. Make sure the Move to next error after solving this one check box is selected to let 
the Spell Checker know that you want to move onto the next misspelled word when 
you have finished correcting the current one. 

3. You can now use the following buttons to correct your spellings: 

• Change button – select a word from the Word list box and then click on this 
button to change the misspelled word to the selected word  

• Change all button – select a word from the Word list box and then click on this 
button to change all instances of the misspelled word throughout your document 

• Add custom button – click on this button to add the selected word to your 
custom dictionary  

• Auto Correct button – select a word from the Word list box and then click on this 
button to add the misspelled word to the auto correct file. In future, when you 
type the word incorrectly, the Spelling facility will now automatically change the 
word to the selected word  

• Ignore button – click on this button to ignore the misspelled word. 

4. The Spelling Helper window closes as soon as the spell check is complete. If it 
doesn’t, click on the  button on the top right-hand corner of the window. 

5. Click on the  drop down list on the toolbar and select Spelling Options.  

You see the Custom tab of the Spelling Options window. Click on the Settings tab 
(Figure 4-2). 

 

Ignore list section

Your search 
methods section

Vocabulary section

Figure 4-2 Settings tab 

6. Select the Ignore domain names (e.g. www.TextHelp.com) check box in the Ignore 
list section and then make sure all other check boxes in this section are de-selected. 

7. Make sure all of the check boxes in the Your search methods section are selected to 
specify that you want the Spell Checker to search for all possible types of mistakes. 
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8. Make sure the US English check box in the Vocabulary section is selected so that 
the Spell Checker will search for mistakes using US English. 

9. Click on the OK button to save your settings and to close the Spelling Options 
window. 

Exercise 2 Using the Auto Correct file and spell checking as you type 
In this exercise you’ll learn how to configure the Spell Checker to automatically correct 
commonly misspelled words and to spell check as you type. 

1. Click on the  drop down list on the toolbar and select Spelling Options.  

You see the Custom tab of the Spelling Options window displayed.  

2. Make sure the Advanced options check box in the bottom left-hand corner is 
selected and then click on the Automatic tab (Figure 4-3).  

 

Use automatic corrections to replace
the text as you type check box

Common Error text box Correction text box

Automatic corrections  
list box  

Figure 4-3 Automatic tab 

You may see a list of words in the Automatic corrections list box. The words listed 
will be automatically changed to the correct spelling if you accidentally type them 
when creating future documents. 

Advanced options
check box

3. Make sure the Use automatic corrections to replace the text as you type check 
box is selected. 

4. Click on the New button.  

5. Type gramar in the Common Error text box and then type ‘grammar’ in the 
Correction text box. Click on the Save button to add it to the list. 

6. Click on the OK button to save the new settings and to close the Spelling Options 
window. 

7. Click on the  drop down list on the toolbar and select Spell As I Type.  

8. Type the following text into your document: 
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 There are deliberate spelling mistakes in the text that you must enter letter for letter. 
They are underlined. You do not need to underline these misspelled words in your 
document. 

His gramar was poore. 
Notice how the Spell Checker automatically corrects the misspelled word you’ve just 
added to the Auto Correct file earlier in this exercise, i.e. ‘grammar’. Also note how 
the Spell Checker then appears after you type ‘poore’. 

9. Click on the  drop down list on the toolbar and de-select Spell As I Type to 
disable this facility. 

Exercise 3 Adding words to the custom dictionary 
You can add words that the spell checker does not recognize to the custom dictionary. 
Once you’ve added a word, the spell checker will no longer highlight it as a misspelled 
word. 

To add words to the custom dictionary: 

1. Click on the  drop down list on the toolbar and select Spelling Options.  

You see the Custom tab of the Spelling Options window (Figure 4-4).  

 

Change the 
custom dictionary 
button 

Current custom dictionary
 text box

New word text box

Custom dictionary
list box 

Figure 4-4 Custom tab 

The custom dictionary that you are currently using is displayed in the Current 
custom dictionary text box. 

2. Type the word Bannack in the New word text box.  

3. Click on the Add word button. ‘Bannack’ is added to the Custom dictionary list box. 
Click on the Speak button to hear the word read aloud 

4. Click on the OK button to save the settings and to close the Spelling Options window. 
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Exercise 4 Reviewing spellings 
In this exercise you’ll learn how to review suggestions for misspelled words and review 
your spelling log. 

1. Click on the  drop down list on the toolbar and select Spelling Options. You see 
the Custom tab of the Spelling Options window displayed.  

2. Make sure the Advanced options check box in the bottom left-hand corner is 
selected and then click on the History tab (Figure 4-5).  

 

 
Error type column  

Recent errors list box

 
Suggestions column 

Advanced options check box 

Figure 4-5 History tab 

3. Select ‘puled’ from the Recent errors list box. You see a list of possible corrections 
and the error types in the Suggestion and Error type columns. 

4. Click on the Log tab (Figure 4-6). 

 
Figure 4-6 Log tab 
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You can see a record of all the words you have misspelled. 

If you see a spelling error that you would like the Spelling facility to automatically 
change to the correction listed in the Log tab, click on the correction and then click on 
the Auto add button to add it to the Auto Correct file.  

5. Click on the Print log button. Microsoft Word launches and you see the spelling log 
for your user account displayed in a new document. 

Exercise 5 Adding a phonetic replacement 
In this exercise you’ll learn how the Spelling facility uses a phonetic map to make 
suggestions for misspelled words. Phonetic maps help the Spell Checker to find 
corrections for difficult spelling errors such as phonetic errors and errors caused by OCR. 
It uses groups of letters that sound the same or are normally confused. 

For example, if you often type ‘telefone’ or ‘elefant’, Read&Write 9 GOLD will be able to 
use the phonetic mapping ‘f = ph’ to solve these errors. 

Read&Write 9 GOLD can also solve spelling errors where there are many phonetic errors 
in one word. For example, if you type ‘nolij’, Read&Write 9 GOLD uses the phonetic 
mappings ‘no = know’ and ‘ij = edge’ to solve the error and suggest ‘knowledge’.  

1. Type the letters noledge into your document. 

2. Highlight the word you’ve just typed and then click on the  button on the toolbar.  

You see the Spelling Helper window displayed. Note that the Spelling facility has 
suggested the word ‘knowledge’ as a replacement. 

3. Click on the  button on the top right-hand corner of the Spelling Helper window to 
close it. 

4. Click on the  drop down list on the toolbar and select Spelling Options. You see 
the Custom tab of the Spelling Options window displayed.  

5. Make sure the Advanced options check box in the bottom left-hand corner is 
selected and then click on the Phonetics tab (Figure 4-7). 
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Phonetic map list box

Advanced options check box

Figure 4-7 Phonetics tab  

The phonetic replacements already present on the phonetic map are listed in the 
Phonetic map list box.  

6. Find the phonetic replacement for ‘no=know’ in the Phonetic map list box. When you 
typed the word ‘noledge’ in step 1, the Spelling facility was able to use this phonetic 
replacement to suggest the word ‘knowledge’ as a replacement word.  

You can add new phonetic replacements or delete them completely.  

7. Click on the OK button to close the Spelling Options window. 
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5. PREDICTING TEXT 

In this section you’ll learn how to: 

• use the Prediction facility 

• change the appearance and behavior of the Prediction window 

• set up prediction speech options 

• teach the Prediction facility new vocabulary patterns 

• set up phonetic replacements 

• add prediction databases 

• edit phrases in the prediction database. 

Exercise 1 Using Word Prediction 
In this exercise you’ll learn how to use the Word Prediction to help you finish sentences. It 
will access a list of words that’ll complete the one that you are currently typing and will 
also try to predict your next word as you finish typing a word. You’ll also learn more about 
using the Display tab of the Predictions Options window. 

1. Open a new blank document in Microsoft Word and then click on the  button on 
the toolbar to display the Prediction window. 

2. Type the following text into your document: I enj  
3. You see a list of words beginning with ‘enj’ displayed in the Prediction window. 

4. Click on ‘enjoyed’ in the Prediction window or press the appropriate function key on 
your keyboard. The word is inserted into your document, followed by a space. 

5. There’s also a useful feature that allows you to view dictionary definitions and 
homophones in the Prediction window.  

6. Type the following letters into your document: the.  

7. You see a list of words in the Prediction window. ‘their’ and ‘there’ are homophones 
and therefore have the following symbol next to them: . 

8. You are having difficulties deciding which of the two words, ‘their’ and ‘there’, is the 
one you need. Hover your mouse over ‘their’ and then click on the  symbol.  

You see the Dictionary - Basic Definitions window displayed (Figure 5-1). 
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Figure 5-1 Dictionary - Basic Definitions window 

9. You read the definition for the word ‘their’ in the Dictionary meanings list box and 
decide that it’s the word you are looking for. Click on the  button on the top right-
hand corner of the Dictionary window to close it. 

10. Click on ‘their’ in the Prediction window. The word is inserted into your document. 

11. Close Prediction by clicking on the  button. 

Exercise 2 Changing the appearance and behavior of the Prediction 
window 

1. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed (Figure 5-2). 

 

Color palettes 

Prediction window
behavior section

Type the word when 
clicked radio button 

Figure 5-2 Display tab 

2. Make sure the following check boxes are selected in the Prediction window behavior 
section and then click on the OK button: 
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• Insert a space after predictions – instructs the system to automatically insert a 
space after a word when it is inserted 

• Display dictionary buttons – allows you to find the definition of words 
suggested in the Prediction window 

• Indicate words that are homophones – instructs the system to list words that 
are homophones in the Prediction window. 

3. Click on the Color palettes and select the colors you want to use for the background, 
text and highlighting colors in the Prediction window. Make sure you don’t pick colors 
that clash because this will make it hard to read words.  

4. Click on the Change Font button and select a font size of 20. 

5. Select ‘2’ from the Columns drop down list and ‘6’ from the Rows drop down list to 
specify the amount of columns and rows with which you want to display the 
information in the Prediction window. 

6. Click on the  button and as you start to use the word prediction again you will see 
the changes you have made. 

Exercise 3 Setting up prediction speech options 
In this exercise you’ll learn how to configure the system to read aloud words from the 
Prediction window.  

1. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. Click on the 
Speech tab (Figure 5-3). 

 

Speak when mouse pointer
hovers over word check box

Automatically speak the
list of predicted words

check box
Wait time period before 
starting track bar  Loop back to the first word

after all predictions are
spoken check box

Figure 5-3 Speech tab 

2. Select the Automatically speak the list of predicted words check box to specify 
that you want the Prediction facility to speck each word in the Prediction window. 
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3. De-select the Loop back to the first word after all predictions are spoken check 
box to specify that you don’t want the Prediction facility to keep repeating the list of 
predicted words. 

4. Drag and drop the Wait time period before starting track bar until it reaches 2 
seconds to specify that you want the Prediction facility to wait 2 seconds before 
reading the words aloud.  

5. Click on the OK button to save the settings and to close the window. 

6. Open a new blank document in Microsoft Word and then click on the  button on 
the toolbar to display the Prediction window. 

7. Type the following text into your document:     

I want to write a let 
You see a list of words beginning with ‘let’ displayed in the Prediction window. When 
you stop typing, the Prediction facility waits for 2 seconds and then reads aloud each 
of the words. 

8. Click on the word ‘letter’ in the Prediction window or press the appropriate function 
key on your keyboard. The word is inserted into your document, followed by a space. 

9. Open the Speech tab of the Prediction Options window again and de-select the 
Automatically speak the list of predicted words check box to stop the Prediction 
facility from automatically reading words aloud from the Prediction window. 

10. Select the Speak when mouse pointer hovers over word check box to specify that 
you want the Prediction facility to speak a word when you hover your mouse over it in 
the Prediction window. 

11. Click on the OK button to save the settings and to close the window. 

12. Type the following text into your document: 

I want a drink of wat 
You see a list of words beginning with ‘wat’ displayed in the Prediction window. Hover 
your mouse over each word to hear it read aloud. 

13. Click on the word ‘water’ in the Prediction window or press the appropriate function 
key on your keyboard. The word is inserted into your document, followed by a space. 

14. Click on the  button on the top right-hand corner of the Prediction window to close 
it. 

Exercise 4 Teaching the Prediction facility new vocabulary patterns 
In this exercise you’ll learn how to specify exactly how you want the Prediction facility to 
learn vocabulary patterns to improve its predictions. This will only be applied to the user 
account that you used to log into the system. The text file will not be used by any other 
user account. 

Before you begin this exercise, make sure you have a text file containing a 
comprehensive list of words and phrases, saved on your computer. 

1. Type the following text into your document: 
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I like to eat mangoes and bananas in a fruit salad. 

2. Copy the text and then click on the  drop down list and select Create prediction 
word bank from the clipboard. 

You see the Create a new prediction file window displayed (Figure 5-4). 

 
Figure 5-4 Create a new prediction file window 

3. Type the following details: 

• File name – Fruit 

• Description – Fruit I like to eat. 
4. Click on the OK button. 

A message box is displayed. It informs you that a new prediction word bank has been 
created and saved in your User Setting’s folder. It is now available for use. 

You can also teach the Prediction facility new vocabulary patterns from the Learning 
Tab in the Prediction Options. 

5. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. 

6. Select the Advanced options check box in the bottom left-hand corner of the 
window. 

7. Click on the Learning tab (Figure 5-5). 
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Spell check each word
before learning check box

Advanced options
check box

Figure 5-5 Learning tab 

8. Make sure the Spell check each word before learning check box is selected to 
make sure the Prediction facility does not learn any misspelled words to the 
Prediction database. 

9. Click on the File button.  

You see the Open window displayed. 

10. Select a file with a '*.txt' file extension and click on the Open button. 

11. Click on the OK button in the Learning tab. 

The words and phrases in the text file will now be used by the Prediction facility to 
provide you with a list of possible words and phrases with which you can finish 
sentences as you type. 

The Prediction facility can also learn words that you’ve copied to the clipboard. To do 
this, you simply click on the Clipboard button in the Learning tab. However, the 
remaining exercises in this chapter show you how to save the clipboard text to a 
prediction file in your user settings. This means that the text can be reviewed and/or 
deleted at a later date. 

Exercise 5 Setting up phonetic replacements 
In this exercise you’ll learn how to set up phonetic replacements which will be used in the 
Prediction facility. Sometimes people make the mistake of spelling words phonetically. For 
example, typing ‘fone’ instead of ‘phone’. Read&Write 9 GOLD's phonetic prediction can 
use phonetic mappings to help suggest the words that you are trying to spell. 

1. Click on the  button on the toolbar. You see the Prediction window displayed. 

2. Type the letters foto into your document. Note how you are also given predictions 
beginning with ‘ph’, e.g. ‘photo’.  

3. Close the Prediction window. 
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4. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. Make sure the 
Advanced options check box in the bottom left-hand corner is selected and then 
click on the Phonetics tab (Figure 5-6). 

 

Predict words using the
phonetic replacements
listed below check box

Phonetic map list box

Figure 5-6 Phonetics tab 

The phonetic replacements already present on the phonetic map are listed in the 
Phonetic map list box. 

Advanced options
check box

5. Find the phonetic replacement for ‘fo=pho’ in the Phonetic map list box. When you 
typed the word ‘foto’ in step 2, the Prediction facility was able to use this phonetic 
replacement to suggest words beginning with ‘photo’ as replacement words.  

6. De-select the Predict words using the phonetic replacements listed below check 
box if you wish to disable this facility. 

7. Click on the OK button to close the Prediction Options window. 

 The Prediction facility will only provide you with a list of predictions using phonetic 
replacements if you have set the context level to ‘More suggestions’ in the Context 
tab. 

Exercise 6 Adding prediction databases 
In this exercise you’ll learn how to add prediction databases. This means that the 
Prediction facility will suggest words based on the databases you have chosen to use. 

1. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. Make sure the 
Advanced options check box in the bottom left-hand corner is selected and then 
click on the Context tab (Figure 5-7). 
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 Advanced options
check box

Figure 5-7 Context tab 

2. Click on the check box beside Applied sciences in the Prediction writing styles section 
and then click on the OK button.  

This will ensure that all words and phrases in the Applied sciences prediction 
dictionary are added to the Prediction facility. 

3. Click on the  button on the top right-hand corner of the Prediction window to close 
it. 

Exercise 7 Editing phrases in the prediction database 
In this exercise you’ll learn how to edit phrases in the prediction database. This means 
that when you next use the Prediction window to predict your next words, it will suggest 
words based on the phrases you’ve edited.  

1. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. Make sure the 
Advanced options check box in the bottom left-hand corner is selected and then 
click on the Edit Lists tab (Figure 5-8).  
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Figure 5-8 Edit Lists tab 

2. Select the All prediction files radio button to specify that you want to search for a 
phrase in all available prediction databases.  

3. Type the word dead into the Search for phrases starting with text box and then 
click on the Search button. You see a list of all the phrases containing the word 
‘dead’ displayed in the Phrase search results list box. 

You notice that the phrase ‘dead quiet’ is not listed. To add this phrase to the list: 

4. Select the Custom prediction file radio button and then click on the New button. 
You see the Add a new word or phrase window displayed. 

5. You must select the Other radio button because the phrase ‘dead quiet’ is an 
adjective. You see a second Add a new word or phrase window displayed (Figure 
5-9).  

 
Figure 5-9 Add a new word or phrase window (2nd window) 

6. Type the phrase dead quiet into the New word or phrase to add text box and then 
type the following text into the first three Phrases text boxes: 

Search for phrases
starting with text box

Phrase search 
results list box

All prediction files  
radio button

Custom prediction file
radio button

Advanced options
check box

Other radio button New word or phrase
to add text box

Phrases text boxes
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• It was dead quiet 

• She is dead quiet 

• They were dead quiet. 
7. Click on the OK button in both the Add a new word or phrase window and the 

Prediction Options window. 

8. Click on the  button and then type the following text into your document followed 
by a space: It was dead. Keep an eye on the Prediction window. You’ll see the word 
‘quiet’ listed. Click on ‘quiet’ or use the appropriate function key to insert it into your 
document. 
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6. USING THE DICTIONARY 

In this section you’ll learn how to: 

• use the basic and advanced dictionaries 

• search for web definitions. 

Exercise 1 Using the dictionaries 
In this exercise you’ll learn how to use the dictionary to find basic and advanced 
definitions. 

1. Type the following text onto a new line in your document: 

Strangers are just friends waiting to happen 
2. Highlight the word ‘happen’. 

3. Click on the  drop down list on the toolbar and select Basic Definitions, then click 

on the  button. From now on the Basic Dictionary will be displayed when you click 
on this button. 

You see the Dictionary - Basic Definitions window displayed (Figure 6-1).  

 

 
Figure 6-1 Dictionary - Basic Definitions window  

The word ‘happen’ is displayed in the Original word text box. You can also see a list 
of definitions for the word ‘happen’ displayed in the Dictionary meanings list box. 

Original word 
text box 

Inflections/Synonyms 
list box 

Dictionary meanings
list box

4. Click on the first definition and then click on the  button on the Read&Write 9 
GOLD toolbar to hear it read aloud. 

5. Type the word approach into the Original word text box and then click on the 
Search button.  

You see a list of definitions for the word ‘approach’ displayed in the Dictionary 
meanings list box. 

Texthelp Systems Limited  Page 37   



Using the Dictionary Read&Write 9   

6. To close the Dictionary - Basic Definitions window, click on the  button on the top 
right-hand corner of the window.  

You want to replace the word ‘happen’ with a word similar to it. You can do this by 
conducting an advanced dictionary search for this word. Complete the following: 

7. Highlight the word ‘happen’ in your text.  

8. Click on the  drop down list on the toolbar and select Advanced Definitions, then 

click on the  button. From now on the Advanced Dictionary will be displayed 
when you click on this button. 

You see the Dictionary - Advanced Definitions window displayed. The word ‘happen’ 
is displayed in the Original word text box. 

9. Click on the Advanced button and select Words related to ‘happen’ from the popup 
menu. You see a list of definitions for the word ‘happen’ in the Dictionary meanings 
list box. 

10. Click on the definition that begins with ‘Come to pass; occur’. The word ‘occur’ 
appears in the Inflections/Synonyms list box and you decide that you want to 
replace the word ‘happen’ in your text with this new word. 

11. Click on the word ‘occur’ in the Inflections/Synonyms list box and then click on the 

 button on the Read&Write 9 GOLD toolbar to hear it read aloud. 

12. Click on the Replace button to replace the word ‘happen’ in your text.  

Exercise 2 Searching for web definitions 
In this exercise you’ll learn how to use Read&Write 9 GOLD to find definitions on the 
Internet. 

You decide that you want to check the definition of ‘strangers' on the web. Complete the 
following: 

1. Click on the  drop down list on the toolbar and select Web Definitions, then click 

on the  button. From now on the Web Definitions Dictionary will be displayed 
when you click on this button.  

You see the Manual Text Search window displayed (Figure 6-2). 

 
Figure 6-2 Manual Text Search window 
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2. Type stranger in the text box provided and then click on the OK button. 

Your browser window automatically opens and displays the Dictionary.com website. 
You can see a list of definitions for the word ‘stranger’. 

3. Click on the  button on the top right-hand corner of the window when you have 
finished viewing this page.  
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7. USING THE WORD WIZARD 

In this section you’ll learn how to use the Word Wizard. 

Exercise 1 Searching for words using the Word Wizard 
In this exercise you’ll learn how to use the Word Wizard to search for specific words. 

To complete this exercise, click on the  button until you can see the All Features 
toolbar. The tooltip for this button will help you identify the toolbar you need. 

1. Type tree onto a new line in your document and then highlight it. 

2. Click on the  button on the toolbar. 
You see the first window in the Word Wizard, which displays the highlighted word. 

3. Click on the Next button. You see the next window in the Word Wizard. 

4. Select the Noun radio button to specify that you are looking for a noun and then click 
on the Next button. 

You see the next window displayed. Read the two senses which provide you with two 
different meanings for the word ‘tree’.  

5. Make sure the first sense (1) is selected and then click on the Next button, i.e. ‘A tall 
perennial woody plant having a main trunk and branches forming a distinct elevated 
crown’. You see the next window in the Word Wizard. 

6. Select the Parts of a ‘tree’ radio button and then click on the Next button. You see 
the next window (Figure 7-1). 

 

Related words or phrases
 list box

Synonyms list box

Figure 7-1 Word Wizard 

7. Click on the first phrase (1) in the Related words or phrases list box, i.e. ‘Stump, 
Tree stump’. You can view a list of related synonyms displayed in the Synonyms list 
box. 

8. Select ‘stump’ from the Synonym list box and then click on the Replace button. 
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‘Stump’ replaces the word ‘tree’ in your text.



 

8. USING THE HOMOPHONES FACILITY 

In this section you’ll learn how to use the Homophones buttons to access and use the 
Homophones facility. 

Type the following text into a blank Microsoft Word document:  

Put the magazine here and clothes the window pleas. 

Exercise 1 Identifying homophones 
In this exercise you’ll learn how to identify homophones in your document to help you 
ensure you’ve typed the correct word. 

1. Click on the  button on the toolbar.  

You see the Same Sounding Words window displayed (Figure 8-1). The first 
homophone in the text is displayed, i.e. ‘the’. 

The homophones in your text are highlighted in blue. They are ‘the’, ‘here’, ‘clothes’ 
and ‘pleas’.  

 

Word meaning list box 
Homophones list box

Move to next 
homophone after this 
check check box 

Figure 8-1 Same Sounding Words window 

2. Make sure the Move to next homophone after this check check box is selected. 

3. You decide that the word ‘the’ is the correct word. Click on the Ignore button. 

The Same Sounding Words window moves on to the next homophone in the 
sentence, which is ‘here’. 

4. You decide that this is the correct word. Click on the Ignore button. 

The Same Sounding Words window moves on to the next homophone, which is 
‘clothes’. 
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5. Make sure the word ‘clothes’ is selected in the Homophones list box and read the 
definition in the Word meaning list box. To hear it read aloud, click on the definition 

and then click on the  button on the toolbar. 

6. Select ‘close’ from the Homophones list box. 

7. Click on the Replace button. 

The Same Sounding Words window moves on to the next homophone, which is ‘the’.  

8. Again, you decide that the word ‘the’ is the correct word. Click on the Ignore button. 

Alternatively you could click on the Always Ignore button to ensure that the word 
‘the’ will no longer be identified as a homophone. 

The Same Sounding Words window moves on to the next homophone, which is 
‘pleas’. 

9. Make sure ‘pleas’ is selected in the Homophones list box. You want to change the 
definition for this word. Click on the Options button. You see the Similar tab of the 
General Options window displayed (Figure 8-2). 

 

Meaning column

Figure 8-2 Similar tab 

10. Insert the cursor after ‘requests for help’ in the Meaning column and then type in the 
following text: ‘,appeals’. Click on the Save button. 

11. A message box is displayed asking you if you are sure you want to save this group 
and make a permanent change. Click on the Yes button to save the change. 

12. Click on the OK button to close the General Options window. 

The Same Sounding Words window is re-displayed. If you want to see the new 
definition for pleas, click on another word in the Homophones list box and then on 
pleas again. 

13. Select ‘please’ from the Homophones list box. 

14. Click on the Replace button. 
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The Same Sounding Words window closes and the word is replaced. Your text should 
now read as follows: Put the magazine here and close the window please. 



 

9. USING THE READ&WRITE 9 GOLD CALCULATORS 

In this section you’ll learn how to: 

• use the Standard Calculator 

• use the Scientific Calculator 

• evaluate calculations within documents 

• convert values in a document. 

Exercise 1 Using the Standard Calculator 
In this exercise, you’ll learn how to use the Standard Calculator. 

1. Click on the  drop down list on the toolbar and select Standard Calculator. 

You see the Standard Calculator window displayed. 

2. Select the following options from the Speech menu: 

• Speak on Click 

• Confirm on Equals. 

3. Complete the following using the View menu: 

• select Background Color, then select a green color from the color palette, and 
then click on the OK button 

• select Foreground Color, then select a navy color from the color palette, and then 
click on the OK button 

• point your cursor over Button Colors, select Number Color from the popup menu, 
then select a yellow color from the color palette and then click on the OK button 

• make sure the Show Audit Trail option is selected. 

4. Click on the following buttons: 5 + 9 + 4 = 

 If you click on the wrong button you can undo your last action by clicking on the Undo 
button. If required, you can click on this button several times if you decide that you 
want to undo several actions. 

The system calculates the sum and then reads it aloud. Your calculator should look 
similar to Figure 9-1. 
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Input Display

Audit Trail 

Figure 9-1 Standard Calculator window 

5. Click on the  button on the top right-hand corner to close the Standard Calculator. 

Exercise 2 Using the Scientific Calculator  
In this exercise, you’ll learn how to use the Scientific Calculator. 

1. Type the following into a blank Microsoft Word document: 638/2. 

2. Highlight the sum in your document and then click on the  drop down list on the 
toolbar and select Scientific Calculator. 

You see the Scientific Calculator window displayed (Figure 9-2). The text you’ve just 
highlighted is displayed in the Input Display. 

 

Input Display
Replace button 

Figure 9-2 Scientific Calculator window 

3. Click on the = button. The answer to the calculation is displayed. 

4. Click on the Replace button. 

The sum you highlighted in step 2 is replaced with the answer 319. 

5. Click on the C button to clear the Input Display. 

6. Click on the View menu and select Variables and Constants to display the Stored 
Constants and Variables window (Figure 9-3). 
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Figure 9-3 Stored Constants and Variables window 

7. Type vat=0.175 into the space provided and then click on the Save button. 

8. Click on the File menu and select the Exit option to close the Scientific Calculator. 

Exercise 3 Evaluating calculations within documents 
In this exercise, you’ll learn how to evaluate calculations in your document without having 
to access the calculators. 

1. Type the following into your Microsoft Word document: 50.00*vat 

2. Highlight the sum in your document and then click on the  drop down list on the 
toolbar and select Evaluate in Document.  

The answer is inserted after the calculation. 

Exercise 4 Converting values in documents 
In this short exercise, you’ll learn how to convert values in your document. In this example 
you’re going to convert a value in centimeters to inches. 

1. Type the following into your Microsoft Word document: 167. 

2. Highlight the figure in your document. 

3. Click on the  drop down list on the toolbar, point your cursor over Convert, then 
Length, then centimeters, and then select to inches as shown in Figure 9-4. 

 
Figure 9-4 Conversion menu option 

The figure in your document is replaced by the inches equivalent (65.7480336).

Texthelp Systems Limited Page 47 



 

10. WORKING WITH DAISY BOOKS 

In this section you’ll learn how to: 

• read Daisy books 

• navigate through a Daisy book. 

Exercise 1 Reading Daisy books 
Before you begin this exercise, make sure you have a Daisy book saved on your 
computer. 

 If you don’t have a Daisy book to work with, you can carry out a search on the 
Internet for Daisy Books. 

 

 You can open an AudioPlus book which you may have received from the RFB&D 
(Recordings for the Blind and Dyslexic). However, you cannot use the Read&Write 9 
GOLD toolbar to read the chapters aloud. Instead, you can use the Speech buttons at 
the bottom of the Daisy Reader window. 

1. Click on the  drop down list on the toolbar and make sure the Read by sentence 
option is selected. You’ll know it has been selected if you see a dot beside it, as 
shown below:  

 

2. Click on the  button on the toolbar. 

You see the Browse For Folder window displayed.  

3. Browse to the location in the directory where you have saved the Daisy file, select it 
and then click on the OK button. 

 If you are opening an AudioPlus book, you must browse to the location of your User 
Authorization Key, select it and then click on the Open button. You can then enter the 
PIN code supplied to you by the RFB&D. 

The Daisy book opens in the Daisy Reader window. 

4. The table of contents for the book is displayed on the left-hand-side of the Daisy 
Reader window. Click on a page/section to view it. 

5. Complete either of the following options: 

• if web highlighting is switched on, hover your mouse over the area of text you 
want read aloud 
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• if web highlighting is not switched on, click on the  button on the Read&Write 
9 GOLD toolbar. 

6. Click on the Display menu and select Display Options. You see the Display Options 
panel displayed.  

7. Specify that you would like to make the Font Size 20 and the text Bold. If you wish, 
change the Text and Background Color by clicking on the color dropdown. Click on 
the Cancel button when you are happy with the settings. 

Exercise 2 Navigating through a Daisy book 
In this exercise you’ll learn how to find the text that you want to read aloud in the Daisy 
book.  

1. Make sure the Daisy book is open. You may need to complete steps 2 and 3 in the 
previous exercise. 

2. Click on the appropriate Navigation button to move through the pages: 

•  – displays the first page in the book 

•  – displays the previous page in the book 

•  – displays the next page in the book 

•  – displays the last page in the book. 

Insert bookmarks in the text. To do this: 

3. Click on the  button. You see the Save Bookmark window displayed. 

4. Type Bookmark1 in the text box provided and then click on the Save Bookmark 
button. 

5. Go to another page in the Daisy book and repeat steps 3 and 4 to add another 
bookmark, and call it Bookmark2. 

Now practice finding the bookmarked text: 

6. Select Bookmark1 from the Bookmarks drop down list and then click on the  
button. 

Find specific words in the text. To do this: 

7. Type a word that you know is in your Daisy book, in the Find Text In Book text box, 

and then click on the  button. 

The first instance of the word or phrase is highlighted in your Daisy book. If you want to 

view the next instance, click on the  button again.
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11. USING THE PRONUNCIATION TUTOR 

In this section you’ll learn how to use the Pronunciation Tutor to: 

• check how words are pronounced 

• create syllable exceptions. 

Exercise 1 Checking how words are pronounced 

1. Click on the  button on the toolbar to display the Pronunciation Tutor window 
(Figure 11-1). 

 

Display Phonetic Letters 
check and text box 

Figure 11-1 Pronunciation tab 

Available Voices drop 
down list 

Display Phoneme 
Equivalent check and text 
box 

Phoneme 
Information 
section 

Selected word text box

Display Syllabification text box

Use the lips for pronunciation
check box

Advanced Display check box

2. Click on the  symbol on the bottom right-hand corner of the window and then 
drag and drop the window until it reaches the size most suitable for you. Any window 

that has the  symbol can be resized. 

3. Select ‘Texthelp Jane US’ from the Available Voices drop down list. 

4. Make sure the following check boxes are selected: 

• Advanced Display 

• Use the lips for pronunciation 

• Display Syllabification 

• Display Phonetic Letters 

• Display Phoneme Equivalent. 
5. Type computer into the Selected word text box and then click on the Speak button. 
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Note how the lips and tongue move to show you how to form the word with your 
mouth. Also note how the word ‘computer’ is broken down into three syllables in the 
Display Syllabification text box.  

6. Double click on the letter k in the Display Phoneme Equivalent text box. The 
Phoneme Information section is populated with information, e.g. words that are also 
pronounced using the ‘k’ sound used in ‘computer’ are listed in the Example Words 
text boxes. 

Exercise 2 Creating syllable exceptions 
In this exercise you’ll learn how to teach the system to pronounce the word ‘hungry’ 
differently. You’ll do this using the Pronunciation Tutor. 

1. Type the word hungry into your document, highlight it and then click on the  
button. Notice how the Pronunciation Tutor breaks the word into the syllables ‘hun’ 
and ‘gry’. 

2. Click on the Syllable Exceptions tab (Figure 11-2). 

 

Target Word text box 

Syllable Exceptions
 list box Modified Syllables 

text box 

Figure 11-2 Syllable Exceptions tab 

3. Click on the New button. 

4. Type hungry into the Target Word text box and then type hung-ry into the Modified 
Syllables text box.  

5. Click on the Speak button to hear the new pronunciation read aloud and then click on 
the Save button to add it to the Syllable Exceptions list box. 

6. Click on the  button to close the Pronunciation Tutor window. 
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12. USING THE SCANNING FACILITY 

In this section you’ll learn how to use the Scanning facility to: 

• perform a fast scan 

• scan single documents 

• scan multiple documents 

• scan from a file 

• scan from a digital camera. 

 To complete this section, you must ensure that you’ve set up your scanner correctly 
and have two 8.5x11 colored documents containing text and pictures. 

Exercise 1 Performing a fast scan 
In this exercise you’ll learn how to perform a fast scan. A fast scan allows you to scan 
directly into Microsoft Word, Internet Explorer or Adobe Acrobat. 

1. Place a page into your scanner. 

2. Click on the  drop down list and make sure Scan to PDF is selected. You’ll know 
that it has been selected if you can see a dot beside it: 

 

3. Click on the  button on the toolbar.  

You see the Save As window displayed.  

4. Type My Scan to PDF in the File Name field, locate a file in which to save the scan, 
and then click on the Save button.  

The Scanning facility scans your document. When the scan has completed, you see 
the scanned image displayed in Adobe Acrobat. From here you can use PDFaloud to 
read the document. 

This type of scan is recommended if you simply wish to scan a document and have it 
read. Scanning into PDF provides a ‘near’ picture image of the original document. 

5. Click on the  drop down list and select Scan to Word. 

6. Click on the  button on the toolbar.  

You see the Save As window displayed. 

7. Type My Scan to Word in the File Name field, locate a file in which to save the scan, 
and then click on the Save button. 

The Scanning facility scans your document. When the scan has completed, you see 
the scanned image displayed in Microsoft Word.  
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This type of scan is recommended if you want to edit the scanned document. 

8. Click on the  drop down list and select Scan to HTML. 

9. Click on the  button on the toolbar.  

You see the Save As window displayed. 

e field, locate a file in which to save the 

ee 
xplorer. 

uctions on how to change fonts 

Exercise 2 

ner options and scan single documents. 

10. Type My Scan to HTML in the File Nam
scan, and then click on the Save button. 

The Scanning facility scans your document. When the scan has completed, you s
the scanned image displayed in Internet E

This type of scan is recommended if you want to display the document using your 
own choice of colored fonts and backgrounds. Instr
and backgrounds will be explained later. 

Scanning single documents 
In this exercise you’ll learn how to set up scan

1. Click on the  drop down list on the toolbar and select Scanning Options.  

You see the Output tab of the Scanner Settings window displayed (Figure 12-1). 

 
Figure 12-1 Scanner Settings window – Output tab 

2. Select the 

3. Make sure the Retain full formatting with graphics check box is selected in the 
he OK button.  

Temporary file/folder radio button

Temporary file/folder radio button. 

Word output settings section and then click on t

4. Click on the Scanner tab (Figure 12-2). 

Choose a location to save to
radio button
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Scanner drop 
down list 

Image Resolution
section

Multipage 
Settings 
section  

Color section

Auto check box

Figure 12-2 Scanner Settings window – Scanner tab 

5. Select the type of scanner you are using from the Scanner drop down list. 

6. Make sure the 300 DPI radio button from the Image Resolution section is selected. 

7. Select the Single pages radio button from the Multipage Settings section. 

8. Select the Full color radio button from the Color Settings section. 

9. Select the Auto check box to ensure that the system automatically adjusts the 
brightness of the scan. 

10. Click on the OK button to save your settings. 

11. Place a single page into your scanner and then click on the  drop down list on the 
toolbar and select Scan to Word. 

12. Click on the  button. 

Your page is scanned and automatically opened in Microsoft Word. It is saved in a 
temporary file and folder created by Read&Write 9 GOLD. 

Exercise 3 Scanning multiple documents 
In this exercise you’ll learn how to set up scanner options and scan multiple documents. 

1. Click on the  drop down list on the toolbar and select Scanning Options. 

You see the Output tab of the Scanner Settings window displayed (Figure 12-1). 

2. Select the Choose a location to save to radio button. Click on the Browse button, 
browse to the location of the folder in which you want to save your scanned images, 
enter a name for the image and then click on the OK button. 

3. Select the Use simple HTML, without graphics radio button and then make sure the 
Use custom font and color settings check box is selected.  
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4. Click on the HTML Options button, adjust the following settings for the Font, and 
then click on the OK button: 

• Arial font 

• red color 

• 28 size. 

5. Click on the Scanner tab (Figure 12-2). 

6. If you are using a different scanner form the previous exercise, select the type of 
scanner you are using from the Scanner drop down list. 

7. Select the Multiple pages (countdown) radio button from the Multipage Settings 
section. Type 60 in the Countdown text box. 

8. Select the Auto check box to ensure that the system adjusts the brightness of the 
scan automatically. Move the Contrast scale up to +20%. 

9. Click on the OK button to save your settings.  

10. Place a single page into your scanner and then click on the  drop down list on the 
toolbar and select Scan to HTML. 

11. Click on the  button. 

Your page is scanned and then you will see a 60 second countdown displayed. This 
means you have 60 seconds before your next page will be scanned. 

12. Place another page into your scanner.  

Read&Write 9 GOLD will automatically scan this page 60 seconds after the first page has 
been scanned. You also see it open in Internet Explorer with the font settings you 
specified earlier. Your scanned images are saved in the folder of your choice. 

Exercise 4 Scanning from a file 
You can also scan from a saved image file on your computer. 

1. Click on the  drop down list on the toolbar and select Scan to PDF. 

2. Again, click on the  drop down list and select Scan from File. 

3. Click on the  button. 

The Open files window is displayed. 

4. Browse to the location where you store your images, select the image and then click 
on the Open button. The image is scanned and opened in a PDF file. 

Exercise 5 Scanning from a digital camera 
In this exercise you’ll learn how to scan from a photo you have taken with your digital 
camera. This is useful if you don’t have access to a scanner.  
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 To complete this exercise, your camera must be WIA compatible. If it is not, you can 
use the ‘Scan from File’ as detailed in Exercise 4 above and select your image. 

1. Place an 8.5x11 page of paper containing text on your desk and take a photo of it. 

2. Connect your camera to your computer using your USB cable. 

3. Click on the  drop down list on the toolbar and select Scan from WIA. 

4. Click on the  icon. 

You can see either of the following windows displayed: 

• Select Device window (Figure 12-3) 

 
Figure 12-3 Select Device window 

• Get Pictures from window (Figure 12-4). 

 
Figure 12-4 Get Pictures from window 

5. Complete either of the following tasks, depending on which window you can see: 

• Select Device window – select your camera from the list and then click on the OK 
button. The Get pictures from window is displayed (Figure 12-4). Locate and 
select the photo you have just taken and then click on the Get Pictures button 

• Get Pictures from window (Figure 12-4) – locate and select the photo you have 
just taken and then click on the Get Pictures button. 
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When you display your document you can use the features in Read&Write 9 GOLD to 
read aloud the text in the way that you want.



 

13. USING THE FACT FINDER 

In this section you’ll learn how to use the Fact Finder default search engine. 

Exercise 1 Using the default search engine 
In this exercise you’ll learn how to set up the default search engine and search for facts 
using the default search engine. 

1. In Microsoft Word type in the word ‘dyslexia’.  

2. Select the word and click on the  button. 

3. Your browser window opens displaying the search results for ‘dyslexia’ in Google. 

4. Click on the  drop down list on the toolbar and select Fact Finder Options. You 
see the Fact Finder Options window displayed (Figure 13-1). 

 

Default search engine

Figure 13-1 Fact Finder Options window 

5. Click on the Change Default button and then point your cursor over the Search using 
option. You see a drop down list displaying different categories of search engines. 

6. Point your cursor over General and select the Yahoo search engine. 

7. Click on the OK button to save Yahoo as the default search engine. 

8. Click on the  button on the toolbar. You see the Manual Text Search window, 
allowing you to search for facts using the default search engine, Yahoo (Figure 13-2). 

 
Figure 13-2 Manual Text Search window 

9. Type What are sloths in the text box provided and then click on the OK button. 

Your browser window opens displaying the search results for ‘sloths’ in Yahoo.
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14. USING THE FACT FOLDER 

In this section you’ll learn how to: 

• add text facts 

• add image facts 

• add URLs and documents 

• change fact details and properties 

• export facts. 

 The Fact Folder is used mainly to add facts from the Internet. 

Exercise 1 Adding text facts 
In this exercise you’ll learn how to use the Fact Folder to save a paragraph of text as a 
new fact. Type the following text into a new document: 

The United States of America is comprised of fifty states and one federal district. 
The country celebrates its founding date as July 4th 1776. 
1. Save the document in the directory of your choice. 

2. Highlight this text and then click on the  button. The Fact Details window is 
displayed (Figure 14-1). 

 

Title text box 

Author text box 

Sources list box 

Category text box 

Description text 
box 

Figure 14-1 Fact Details window 

3. Type the text United States of America into the Title text box. 

4. Type your name in the Author text box. 

The locations and URLs of any documents and websites you have open are 
displayed in the Sources list box. 

5. Select the check box beside the location of the document you created in step 1. 
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6. Click on the  button beside the Categories text box. You see the Select 
Categories window displayed. 

7. Click on the Add button and type the text America in the text box provided. 

8. Click on the OK button to add the new category. 

9. Select the check box beside ‘America’ in the Category List and then click on the OK 
button. 

10. Enter the text US States in the Description text box and then click on the OK button. 

You see a message popup from the system tray informing you that the fact ‘United States 
of America’ has been added. 

Exercise 2 Adding image facts 
In this exercise you’ll learn how to use the Fact Folder to save an image from a web page 
as a new fact. 

1. Find a map of America on the Internet and then click on the  drop down list and 
select the Add Web Image option. You see the Texthelp Web Hover popup on the 
bottom right-hand corner of your screen.  

2. Hover your mouse over the image of America until you see it appear in this popup 
and then click on it. You see the Fact Details window displayed (Figure 14-1). 

3. Type the text Map of America into the Title text box. 

4. Type the name of the author of the website in the Author text box. 

The locations and URLs of any documents and websites you have open are 
displayed in the Sources list box. 

5. Select the check box beside the URL which contains the image you have just 
selected. 

6. Click on the  button beside the Categories text box. You see the Select 
Categories window displayed. 

7. Select the check box beside ‘America’ in the Category List and then click on the OK 
button. 

8. Enter the text Map of America in the Description text box and then click on the OK 
button. 

You see a message popup from the system tray informing you that the fact ‘Map of 
America’ has been added. 

Exercise 3 Adding URLs and documents 
You can add a URL by dragging and dropping it from Internet Explorer into the Fact 
Folder. You can use the same method to drag and drop documents from Windows 
Explorer. In this exercise you’ll learn how to add a URL to the Fact Folder and then 
access it directly from the Fact Folder. 

1. Click on the  drop down list and select the Review Facts option. You see the Fact 
Folder window displayed (Figure 14-2). 
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Categories drop 
down list 

Preview pane 

Figure 14-2 Fact Folder window 

2. Find a website which details facts relating to American states. 

3. Click and hold down your left mouse button on the Internet Explorer icon in the 
Address line as shown below (Figure 14-3), then drag and drop it onto the Fact Folder 
window. 

 

Internet Explorer
icon

Figure 14-3 Internet Explorer icon 

You see the Fact Details window displayed (Figure 14-1). 

4. Type the text American states into the Title text box. 

5. Type the name of the author of the website in the Author text box. 

6. Select the check box beside the websites URL in the Sources list box. 

7. Click on the  button beside the Categories text box. You see the Select 
Categories window displayed. 

8. Select the check box beside ‘America’ in the Category List and then click on the OK 
button. 

9. Enter the text Lists of states in the Description text box and then click on the OK 
button. 

You see a message popup from the system tray informing you that the fact ‘American 
states’ has been added. You also see the new fact listed in the Fact Folder. 

10. Click on the  button on the top right-hand corner of your browser window to close 
Internet Explorer. 
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11. Click on the ‘American states’ fact in the Fact Folder window and then click on the 

 button to see the website displayed again in your browser window. 

Exercise 4 Changing fact details and properties 
In this exercise you’ll learn how to change the details of facts that you’ve already added to 
the Fact Folder. You’ll also learn how to update fact content. 

1. Click on the ‘Map of America’ fact in the Fact Folder window. You can see a preview 
of the image in the Preview pane. 

2. Click on the ‘American states’ fact in the Fact Folder window and then click on the 

 button. You see the Fact Details window displayed (Figure 14-1). 

3. Type the text Also lists other useful information in the Description text box and 
then click on the OK button. The description is updated in the Fact Folder window. 

4. Click on the ‘United States of America’ fact and then click on the  button. You see 
the Displaying Fact window. 

5. Add the text The United States shares land borders with Canada and Mexico to 
the text that is already there. 

6. Click on the OK button. 

Exercise 5 Exporting facts from the Fact Folder 
In this exercise, you’ll learn how to select facts and export them to a Microsoft Word 
document. 

1. In the Fact Folder window, select America from the drop down list next to the toolbar. 
This will ensure that only the facts you have added to this category are displayed. 

2. Click on the Tools menu and select the Select All Facts option. 

3. Click on the Tools menu again and select the Export Selected Facts option. You see 
the Export Facts window displayed. 

4. Select the Word Export option. 

 You can also export to a HTML document by selecting the Web Export option. 

5. Click on the Browse button. The Select Export File window is displayed. 

6. Browse to the location where you want to save the Microsoft Word document and 
type American in the File name field. Click on the Save button and then click on OK. 

Read&Write 9 GOLD automatically creates the Microsoft Word document and lists all the 
selected facts for the America category. 
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15. USING THE FACT MAPPER 

In this section you’ll learn how to: 

• create fact maps 

• open fact maps and add notes to facts 

• use the Image Library to add images to a map 

• link facts 

• change how a fact map is displayed 

• brainstorm 

• export fact maps. 

You use the Fact Mapper, which is an online graphical user interface, to add different 
types of facts to a fact map. You can then link each of the facts to each other to represent 
a relationship between them. This enables you to create a diagram of your ideas and 
information on a particular subject and therefore help you understand it a lot better. 

To access the Fact Mapper, click on the  button on the Read&Write 9 GOLD toolbar. 
You see the Fact Mapper window displayed (Figure 15-1). 

  

Zoom 
buttons 

Menu

Work area 

Menu 
type

Figure 15-1 Fact Mapper window 

The first time you attempt to use any of the facilities in Fact Mapper, you see the following 
message box (Figure 15-2). Click on the Allow access button. 

 
Figure 15-2 Clipboard message 
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 When working with fact maps, make sure you save before closing the Fact Mapper or 
you will loose your work. 

Exercise 1 Creating fact maps 
In this exercise, you’ll learn how to create a fact map and add facts. 

1. Click on the green option on the Theme palette:  

Wait a few moments while the Fact Mapper changes the color of the window to green. 

2. Change it back to the original blue color, i.e. the first color on the Theme palette, or 
select the color of your choice. 

3. Click on the File menu in order to view the File toolbar (Figure 15-3): 

 The ‘Menu type’ label in Figure 15-1 can help you find this menu.  

 
Figure 15-3 File toolbar 

4. Click on the Fact Map menu in order to view the Fact Map toolbar (Figure 15-4): 

 
Figure 15-4 Fact Map toolbar 

5. Click on the  button on the Fact Map toolbar. 

A new fact is displayed in the main work area. 

6. Type the text America into the new fact:  

 
Figure 15-5 America fact 

7. Click on the America fact and then click on the  button. 

A new fact is displayed in the main work area and is linked to the first fact.  

8. Type the text Map of America into the new fact. 

9. Add the following facts to the fact map using the same process:  

 Make sure that you click on the America fact before you add them. 
 

 You may need to drag and drop the last fact onto a different position on the fact map 
to ensure that you can easily see it coming from the America fact. 
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• United States of America 

• American states 

• Flag. 

The Fact map should look like Figure 15-6: 

 

File menu  

Figure 15-6 Fact Mapper window with facts 

10. Click on the  and  buttons at the top right-hand-side of the Fact Mapper window 
to select the zoom level at which you want to view the fact map. 

11. Select the ‘Flag’ fact and then click on the  button. This fact is removed from the 
fact map. 

12. Click on the File menu and then click on the  button. 

You see the File Download window. 

13. Click on the Save button. 

The Save As window is displayed. 

14. Browse to the folder in the directory in which you want to save the fact map, type the 
name America in the File name text box and then click on the Save button. 

The Download complete window is displayed. 

15. Click on the Close button. 

 Any time you need to save the fact map in future, you will have to override the file you 
just saved. 

16. Click on the File menu and select the Exit option: 
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Figure 15-7 Exit option in File menu 

17. Click on the Yes button when you are asked to confirm the closure of the window. 

Exercise 2 Opening fact maps and adding notes to facts 
In this exercise, you’ll learn how to open fact maps and add Sticky notes to facts. 

1. Click on the  button on the Read&Write 9 GOLD toolbar to access the Fact 
Mapper window (Figure 15-1). 

 Remember to click on the Allow access button when you see the Clipboard message 
(Figure 15-2). 

2. Click on the File menu. 

3. Click on the File menu again and select the Open option (Figure 15-7). 

You see the Open File window displayed (Figure 15-8): 

 
Figure 15-8 Open File window 

4. Click on the Browse button. 

You see the Choose file window displayed. 

5. Locate the America fact map and then click on the Open button.  

You see the Open File window re-displayed. 

6. Click on the OK button. 

The America fact map opens in the Fact Mapper window (similar to Figure 15-6). 

7. Select the ‘American states’ fact. 

8. Type the following text into the text area at the bottom of the Fact Mapper window 
(Figure 15-9): 

There are 50 states in the USA. 

Page 66 Texthelp Systems Limited  



Read&Write 9  Using the Fact Mapper 

 

Fact Map 
menu

Add note text
here

Figure 15-9 Fact Mapper window: adding notes 

9. Click on the  button. The Post It note is added to the fact. It is represented by the 

 icon. 

10. Select the ‘United States of America’ fact. 

11. Type the following text into the text area at the bottom of the Fact Mapper window: 

The motto for the USA is ‘In God We Trust’.  

12. Click on the  button. The Post It note is added to the fact. 

13. Select the ‘American states’ fact and then click on the  button at the bottom of the 
Fact Mapper window. The Post It note is removed from the fact. 

14. Make sure the ‘American states’ fact is still selected. 

15. Click on the Fact Map menu and then click on the  button. 

16. Change the name of the fact to the following: 50 states. 

17. Save the fact map. 

Exercise 3 Using the Image Library 
In this exercise, you’ll learn how to add images from the Image Library to your fact map. 

1. Type America in the Search textbox at the bottom right-hand-side of the Fact 
Mapper window. 

2. Click on the Go button. The Search tab expands to display the list of images that 
match your search word.  

3. Click and hold down your left mouse button on the American Coin image and drag 
and drop it onto the ‘America’ fact in the fact map: 
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Figure 15-10 American Coin image 

 If you find it difficult to drag and drop images, you can right-click on an image and 

select ‘Copy Image’, then select a fact in the fact map and click on the  button (on 
the Fact Map menu).    

4. Click and hold down your left mouse button on the American Football image and drag 
and drop it onto the ‘50 states’ fact in the fact map: 

 
Figure 15-11 American Football image 

5. Right-click on the ‘50 states’ fact and select Restore Default Image from the popup 
menu. 

6. Save the fact map. 

Exercise 4 Linking facts 
In this exercise, you’ll learn how to remove links between facts and create them again. 

1. Click on the ‘Map of America’ fact and then click on the  button (on the Fact Map 
menu). The fact is highlighted in blue to show that it has been selected. 

2. Click on the ‘America’ fact.  

The link between the two facts is removed. 

3. Repeat this process to remove the remaining links from the fact map: 

• United States of America 

• 50 states. 

To reinsert the links: 

4. Click on the ‘America’ fact and then click on the  button (on the Fact Map menu). 
The fact is highlighted in blue to show that it has been selected. 

5. Click on the ‘Map of America’ fact. 

You now see a line linking the two facts. 
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6. Repeat this process to link the remaining facts to the ‘America’ fact. 

7. Save the fact map. 

Exercise 5 Changing how a fact map is displayed 
In this exercise you’ll learn how to specify how you want your fact map displayed. You’ll 
also learn how to print your fact map. 

1. Click on the  drop down list (on the Fact Map menu) and select the Document 
Outline option. Your fact map is now displayed in a bulleted list. 

2. Click on the  drop down list again and select the Tree option. Your fact map is 
now displayed in a tree view. 

3. Change it back to the way it was originally by selecting the Fact Map option from the 

 drop down list. 

4. Select ‘America’ in your fact map and then click on the  button. You see the 
Arrange Facts window displayed (Figure 15-12). 

 
Figure 15-12 Arrange Facts window 

 You were asked to select ‘America’ because it is the category to which all of the facts 
are linked.  

5. Select the Bottom Up Tree arrangement and then click on the OK button. 

 The description of each arrangement will help you decide which one you want to use 
in future. 

The facts in your fact map are rearranged so that the American flag is displayed at 
the bottom and all the other facts are displayed above. 

6. Click on the  button (on the File menu).  
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You see the Print window displayed. 

7. Select your preferred print options and then click on the Print button. 

Exercise 6 Brainstorming 
In this exercise you’ll learn how to use the Fact Mapper to brainstorm. This will entail 
adding several American states to a fact map as quickly as possible. 

1. Click on the  button (on the File menu). 

A blank fact map is opened in the Fact Mapper and the Fact Map menu is displayed 
at the top. 

2. Click on the  button. 

A new fact is displayed in the main work area. 

3. Type the text American states into the new fact: 

 
Figure 15-13 American states fact 

4. Make sure the American states fact is selected and then click on the  button. 

A new fact is displayed on top of the American states fact. 

5. Type the text Arizona into the new fact and then press Enter: 
Another fact is added to the work area and is automatically linked to the first fact. 

6. Add the following facts using the same process: 

• Alabama 

• Georgia. 

7. Click on a blank area on the fact map to stop using brainstorming. 

Your fact map should look like Figure 15-14:  
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Figure 15-14 Fact Mapper window: brainstorming 

8. If you wish to add more states, click on the  button or the  button. 

Exercise 7 Exporting fact maps 
In this exercise you’ll learn how to export a fact map to a Microsoft Word document. 

1. Click on the  button (on the File menu). 

The fact map is opened and displayed in Microsoft Word. It is displayed in Document 
Outline view. 

2. Close Microsoft Word. 

 You can also export a fact map to Microsoft Word or to an HTML page by clicking on 
the File menu on the left-hand-side of the File toolbar and selecting Export. The 
Export Facts - Webpage window allows you to select the option you prefer. 
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16. USING SCREEN MASKING 

In this section you’ll learn how to: 

• change display options when using Screen Masking 

• use the spotlight. 

Exercise 1 Using Screen Masking and changing the display options 
In this exercise you’ll learn how to use the Screen Masking defaults and then change how 
you want it displayed. 

1. Open a document in Microsoft Word and then click on the  button on the 
Read&Write 9 GOLD toolbar.  

The Windows system background color changes to yellow. 

2. Click on the  drop down list. 

You see the Display tab of the Screen Masking Options window (Figure 16-1). 

 
Figure 16-1 Screen Masking Options window: Display tab 

3. Select the Tint the line I’m typing on option from the Select Masking Type drop down 
list. 

4. Select a blue color from the Color used when masking the screen color palette. 

5. Adjust the Transparent/Opaque track bar until you have selected a more transparent 
color, i.e. move the scale more to the left.  

6. De-select the Set system background color to the selected masking color check 
box. 

7. Click on the OK button. 
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8. Type the following text into a blank Microsoft Word document: 

This is Screen Masking. 
Notice how the Screen Masking facility tints the line of text you type on. 

9. Click on the  button to disable the facility. 

You can practice setting up some of your own display options. 

Exercise 2 Using the spotlight 
In this exercise you’ll learn how to use the spotlight. 

1. Click on the  drop down list on the Read&Write 9 GOLD toolbar.  

You see the Screen Masking Options window (Figure 16-1). 

2. Select the Tint my whole screen option from the Select Masking Type drop down list. 

 You can only enable the spotlight when you have chosen to tint the whole screen. 

3. Adjust the Transparent/Opaque track bar until you have selected a more opaque 
color, i.e. move the scale more to the right. 

4. Make sure the Set system background color to the selected masking color check 
box is de-selected.  

5. Click on the Spotlight tab (Figure 16-2). 

 
Figure 16-2 Spotlight tab 

6. Make sure the Use the Mouse Spotlight when tinting the whole screen check box 
is selected. 

7. Make the spotlight larger by moving the Height of Mouse Spotlight track bar more to 
the right. 

8. Click on the OK button. 
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9. Click on the  button. 

10. Move your mouse across the screen and notice how the spotlight works. 

11. Click on the  button to disable the facility when you have finished. 

 

The other Masking Types are as follows: 

• Tint the window I’m typing in 

• Tint everything except the window I’m typing in 

• Tint everything except the line I’m typing on 

• Underline the line I’m typing on 

• Underline my mouse pointer 

• None.
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17. USING THE SPEECH INPUT FACILITY IN XP 

In this section you’ll learn how to: 

• add user profiles 

• create a document 

• set up and use the Alternatives window. 

To complete this section, you must ensure that: 

• you’re in a quiet room and are not likely to be distracted 

• you’ve clicked on the  button and can see the Texthelp Speech Input window  

• you’ve followed the instructions in ‘Adjusting the microphone’ in the online help to 
ensure that you’ve positioned your microphone correctly. 

Exercise 1 Adding your user profile 
In this exercise you’ll learn how to add your user profile to the Speech Input facility so that 
it can save your own personal voice settings. 

1. Click on the  button. 

You see the Speech Input User Profile window displayed (Figure 17-1). 

 
Figure 17-1 Speech Input User Profile window  

2. Type your name in the Add a new profile text box and then click on the Add button 
to add your user profile. 

The first step in the Training Wizard is displayed. 

3. Follow the on screen instructions to train the Speech Input facility to recognize your 
voice. 
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Exercise 2 Creating documents 
In this exercise you’ll learn how to create documents using the Speech Input facility. 

1. Click on the  button. 

You see the Document Options window displayed (Figure 17-2). 
 

 

Document Font size 
drop down list 

Document Font drop 
down list 

More/Less button 

Alternatives window
settings section

Figure 17-2 Document Options window  

2. Select Times New Roman from the Document Font drop down list and 14 from the 
Document Font Size drop down list. 

3. Click on the OK button to save the new settings and to close the Document Options 
window. 

4. Make sure you can see the  button on the toolbar. If you can’t see it, click on the 

 button. 

5. Read the following text into the microphone: 

‘Fred the frog sat on his old mushroom, very tired of his surroundings. One 
day, a turtle called Nemo walked slowly by his mushroom. Fred jumped down 
to say hello.’ 

6. Click on the  button to hear the text read back to you. After a few seconds, click 

on the  button to stop the system from reading the text aloud. Click on the  
button again to resume. 

You notice that the Speech Input facility has difficulty pronouncing the name ‘Nemo’. 

7. Click on the  button.  

You see the Add/Delete Words window displayed (Figure 17-3). 
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Word text box

Dictionary list box

Figure 17-3 Add/Delete Words window 

8. Type Nemo in the Word text box. 

9. Click on the Record pronunciation button and then speak the word ‘Nemo’ into the 
microphone. The word ‘Nemo’ is added to the Dictionary list box. 

10. Click on the  button to close the Add/Delete Words window and to return to the 
Speech Input window.  

11. Click on the File menu and select Save As. 

The Save As window is displayed. 

12. Type Speech Input test in the File name field. 

13. Browse to the location in which you want to save the document and then click on the 
Save button. 

Exercise 3 Using the Alternatives window 
In this exercise you’ll learn how to use the Alternatives window to view a list of alternative 
words which you can then insert into your document. 

 You can use the Document Options window (Figure 17-2) to change the Alternatives 
window display settings. 

1. Click on the  button to enable the Alternatives window. Highlight the word 
‘jumped’ in your document. 

You see the Alternatives window displayed. 

2. Scroll through the list until you find the word ‘leapt’ and then double click on it. 

You see the word you highlighted in step 1 replaced with the word you’ve just selected. 

Texthelp Systems Limited Page 77 



 

18. USING THE SPEECH INPUT FACILITY IN VISTA 

In this section you’ll learn how to: 

• set up the Speech Input facility 

• create text using Speech Input 

• correct text 

• add words to the Speech Dictionary. 

To complete this section, you must ensure that you’re in a quiet room and are not likely to 
be distracted. 

 This exercise assumes that the Speech Input facility has not been previously used. 

Exercise 1 Preparing to use the Speech Input facility 
In this exercise you’ll learn how to start the Speech Input facility, correctly position the 
microphone and carry out a training exercise.  

1. Click on the  button on the toolbar. 

You see the Speech Input window displayed (Figure 18-1). 

 

New Profile
text box

Figure 18-1 Speech Input window 

2. Type your name in the New Profile text box and then click on the OK button to add 
your user profile. 

The Microphone Setup Wizard is displayed (Figure 18-2). 
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Figure 18-2 Microphone Setup Wizard 

3. Follow the instructions in the wizard to ensure that the microphone is in the correct 
position. 

When you have finished adjusting the microphone, the Speech Recognition Voice 
Training Wizard is displayed (Figure 18-3). 

 
Figure 18-3 Speech Recognition Voice Training wizard 

4. Follow the instructions in the wizard to train the Speech Input facility to recognize your 
voice. 

You can pause the training at any stage by clicking on the  button. The 
more training you do the better the Speech Input facility will be at recognizing your 
voice. 

Exercise 2 Create text using the Speech Input facility 
In this exercise you’ll learn how to start the Speech Input facility and create text by reading 
into the microphone.  

1. Click on the  button on the toolbar. 

You see the Speech Input panel (Figure 18-4). It is currently in ‘Listening’ mode. 
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Figure 18-4 Speech Input panel – Listening mode 

2. Open Microsoft Word. 

3. Speak the following text into the microphone: 

‘Fred the frog sat on his old mushroom, very tired of his surroundings. One 
day, a turtle called Nemo walked slowly by his mushroom. Fred jumped down 
to say hello.’ 

 Don’t worry if the Speech Input makes a mistake. You will learn how to correct 
mistakes in the next exercise. 

4. Click on the  button on the toolbar.  

The text you just spoke into the computer is read back to you. 

5. Click on the  button on the Speech Input panel. 

The Speech Input panel changes to ‘Sleeping’ mode (Figure 18-5). 

 
Figure 18-5 Speech Input panel – Sleeping mode 

 You can toggle between the Listening and Sleeping modes by clicking on the  
button.  

Exercise 3 Correcting text using the Speech Input facility 
In this exercise you’ll learn how to correct any mistakes the Speech Input facility may have 
made.  

1. Open a new Microsoft Word document. 

2. Click on the  button on the toolbar. 

3. Speak some text into the microphone and stop immediately after a any word which is 
recorded incorrectly. 

4. Speak the following into the microphone: 

Correct that. 
You see the Alternates panel displayed (Figure 18-6). 
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Spell it

Figure 18-6 Alternates panel 

5. Say the number displayed next to a word (or group of words) you would like to use 
instead. 

The Speech Input facility replaces the word in your text. 

6. Speak some more text into the microphone and only stop after speaking several 
sentences, i.e. after the software has made a couple of mistakes. 

7. Speak the following into the microphone: 

Correct ‘say the word that was recorded incorrectly’. 
The Alternates panel is re-displayed 

 If the incorrect word appears more than once, each instance will have a number 
beside it. In this case, you speak the following into the microphone: Correct ‘number 
displayed beside the instance you want to correct’. 

8. You can now either: 

• say the number displayed next to a word (or group of words) you would like to 
use instead. The Speech Input facility replaces the word in your text 

• click on Spell it if your correction does not appear in the Alternates panel. 

You see the Spelling panel (Figure 18-7). Continue with the steps. 

 
Figure 18-7 Spelling panel 
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9. Spell aloud a word you would like to insert in the text, in place of the original word, 
and then click on the OK button. 

10. Close the Alternates panel. 

Exercise 4 Adding words to the Speech Dictionary 
In this exercise you’ll learn how to add words to the Speech Dictionary. This is useful for 
any words that the Speech Input frequently mishears or does not recognize. 

1. Click on the  drop down list and select the Open Speech Dictionary option.  

You see the Speech Dictionary window displayed (Figure 18-8). 

 
Figure 18-8 Speech Dictionary window 

2. Click on Add a new word. 

You see the second step of the Speech Dictionary window displayed (Figure 18-9). 

 

 
Figure 18-9 Speech Dictionary window: second step 

Word or Expression
text box 
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3. Type the word entrepreneurial into the Word or Expression text box, and then click 
on the Next button. 

You see the third step of the Speech Dictionary window displayed (Figure 18-10). 

 

Record a 
ronunciation 
upon Finish 
radio button

p

Figure 18-10 Speech Dictionary window: third step 

4. Select the Record a pronunciation upon Finish check box, and then click on the 
Finish button. 

You see the fourth step of the Speech Dictionary window displayed (Figure 18-11). 

 
Figure 18-11 Speech Dictionary window: fourth step 

5. Click on the Record button and then say the word into the microphone. 

 You can hear the word read back to you by clicking on the Listen button. 

6. Click on the Finish button. 
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19. USING THE TRANSLATOR FACILITY 

In this section you’ll learn how to: 

• translate English words into another language 

• configure the Translator facility. 

Type the following text into a blank Microsoft Word document: 
It was dead quiet and empty black, except for the starlight. 

 You must be online in order to use the Translator facility. 

Exercise 1 Translating English words into another language 
In this exercise you’ll learn how to translate words from English into another language.  

1. Click on the  button on the toolbar. You see the Translation tab of the Translator 
window displayed (Figure 19-1). 

 

Word to search text box

Suggested meanings for
selected word panel

Figure 19-1 The Translator window: Translation tab 

2. Click on the Preferences tab (Figure 19-2). 
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Figure 19-2 Preferences tab 

3. Select the Spanish option from the Translation Language drop down list.  

4. Click on the Translation tab. 

5. Highlight the word ‘dead’ in your document.  

You see the word ‘dead’ displayed in the Word to search text box and a list of 
Spanish translations displayed in the Suggested meanings for selected word 
panel. 

6. Click on the Spanish translations to hear them read aloud. 

7. Highlight the word ‘empty’ in your document to view a list of Spanish translations in 
the Translator tab. 

Exercise 2 Configuring the Translation facility 
In this exercise, you’ll learn how to use the Preferences tab to configure speech, text and 
display options. 

1. Click on the Preferences tab in the Translator window (Figure 19-2). 

2. Select the French option from the Translation Language drop down list. 

3. Adjust the Voice Speed track bar to the setting ‘30’. 

4. Make sure the Get selected text and captions radio button is selected to specify 
that you’d like to select words for translation by simply highlighting them in your 
document.  
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5. Click on the  button in the Background color section and select a pink color for 
the background of the text in the Translation tab. 

6. Click on the Translation tab (Figure 19-1). 

7. Highlight the word ‘starlight’ in your text.  

You can now see the translations for the word ‘starlight’ in the Suggested meanings for 
selected word panel. 
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20. USING STUDY SKILLS 

In this section you’ll learn how to:  

• collect text that you can use for your studies 

• summarize the text that you have collected. 

You can use Study Skills to highlight pieces of text which you may find of interest within a 
Microsoft Word document or Internet Explorer, and collate the highlighted text into a new 
document.  

Read&Write 9 GOLD also allows you to summarize text in your document/web page using 
Study Skills. 

To access Study Skills, click on the  button until you can see the Study Skills 
buttons. The tooltip for this button will help you identify the buttons you need. 

Exercise 1 Collecting text for your studies 
In this exercise you’ll learn how to collect different types of text and then insert them into a 
new document in the order in which you want them displayed.  

1. Open your Internet browser window and then open one of your favorite websites. 

Alternatively, open a Microsoft Word document of your choice. 

 The webpage or Microsoft Word document must have several paragraphs of text.  

2. Highlight the first paragraph on the page and then click on the  (Highlight green) 
button. 

Read&Write 9 GOLD highlights the text in green. An example is shown below: 

 

3. Highlight another paragraph on this page and then click on the  (Highlight pink) 
button.  

Read&Write 9 GOLD highlights the text in pink. 

4. Repeat step 3 to highlight two further separate paragraphs in pink. 

5. Highlight one of the paragraphs in pink and then click on the  (Clear highlights) 
button.  

Read&Write 9 GOLD de-selects the highlighted text in pink. 

6. Click on the  (Collect highlights) button. 

The Collect Highlights window is displayed (Figure 20-1). 
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Figure 20-1 Collect Highlights window 

7. Make sure the following options are selected: 

• Collect green check box 

• Collect pink check box 

• Order highlights by collection time radio button 

• the None option is selected from the Color collections separation drop down 
list 

• the New line option is selected from the Highlighted items separation drop 
down list. 

8. Click on the OK button. 

Read&Write 9 GOLD collects the highlighted text and inserts it into a new Microsoft 
Word document. 

9. Save your document and call it My Studies. 

Exercise 2 Summarizing text for your studies 
In this exercise you’ll learn how to summarize text on a webpage. Read&Write 9 GOLD 
can also summarize text in a document. 

1. Open your Internet browser window and then open one of your favorite websites. 

 The web page must have several paragraphs of text. 

2.  Highlight all of the text on this page using your mouse. 

3. Click on the  (Summary) button. 

The Summary Option window is displayed (Figure 20-2). 

 
Figure 20-2 Summary Option window 
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4. Make sure 50% is selected from the Percent of original drop down list. 

Read&Write 9 GOLD displays the summarized text in a new document. Notice the 
AutoSummarize toolbar also displayed (Figure 20-3). 

 
Figure 20-3 AutoSummarize toolbar 

5. Click on the  and  buttons on the AutoSummarize toolbar to decrease and 
increase the percentage of summarized text. Notice how your text changes as you do 
this. 

6. Click on the  button on the AutoSummarize toolbar. 

You can now see the original text displayed, i.e. all of the text that you highlighted on 
the webpage. The summarized text is highlighted in yellow and the rest is displayed 
as faded text. 

7. Click on the  button again to display only the summarized text. 
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21. ADDITIONAL EXERCISES 

In this section you’ll learn how to: 

• read text files and clipboard text 

• set the prediction context level 

• work with Fact Finder search engines 

• set up hotkeys 

• set up autotext 

• load your personal settings. 

Exercise 1 Reading text files and clipboard text 
Before you begin this exercise, make sure you have a text file saved on your computer.  

1. Type the following text onto a new line in your document: 

 Start every day with an inspiring thought. 
2. Highlight the text and then right click and select Copy from the popup menu. 

3. Click on the  drop down list on the toolbar. Point your cursor at Open in Text 
Reader and select the From Clipboard option from the menu. 

You see the text you highlighted in step 1 displayed in the Text Reader window. 

4. Click on the  button on the toolbar to hear the sentence read aloud.  

5. Click on the  button to close the Text Reader window. 

6. Click on the  drop down list on the toolbar, point your cursor at Open in Text 
Reader and select the Text file option from the menu.  

You see the Select file to open in Text Reader window displayed. 

7. Browse to the location in the directory where the text file is located, select the text file 
and then click on the Open button. 

The text is imported into the Text Reader window. 

8. Use the Speech buttons on the Read&Write 9 GOLD toolbar as required and then 
click on the  button to close the Text Reader window. 
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Exercise 2 Setting up the prediction context level 
In this exercise you’ll learn how to set the context level of predictions. This means that the 
Prediction facility will suggest words based on probability and/or accuracy depending on 
which level is set. 

1. Click on the  drop down list on the toolbar and select Prediction Options. 

You see the Display tab of the Prediction Options window displayed. Make sure the 
Advanced options check box in the bottom left-hand corner is selected and then 
click on the Context tab (Figure 21-1). 

 

Context track bar 

Show context sensitivity
accuracy using indicators

check box

Advanced options
check box

Figure 21-1 Context tab 

2. Make sure the Show context sensitivity accuracy using indicators check box is 
selected. 

3. Drag the Context track bar from ‘More suggestions’ to ‘Better context’ and then click 
on the OK button.  

4. Click on the  button and then type the following text into your document. Keep an 
eye on what predictions are offered in the Prediction window: 

The little girl skipped merrily in the playground. 
5. Open the Context tab of the Prediction Options window again. 

6. Drag the Context track bar from ‘Better context’ back to ‘More suggestions’ and then 
click on the OK button.  

7. Re-type the text into your document. Keep an eye on what predictions are now 
offered in the Prediction window. 

There is a stark contrast between ‘More suggestions’, the majority of which appear 
with a black triangle, and ‘Better context’ which appear with a green circle. With 
‘Better context’ there are fewer words predicted but they are more accurate. Please 
choose which setting best suits you. 
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You can also specify which prediction files you want the Prediction facility to use 
when predicting words, by selecting the appropriate check boxes from the list at the 
bottom of the Context tab. For example, if you select the Applied sciences check 
box, the Prediction facility will use words and phrases from the Applied sciences 
prediction file to suggest words in the Prediction window.  

If you have the Teacher’s Toolkit installed, you can add your own prediction files to 
the list at the bottom of the Context tab. 

8. Click on the  button on the top right-hand corner of the Prediction window to close 
it. 

Exercise 3 Working with Fact Finder search engines 
In this exercise you’ll learn how to add new search engines to Fact Finder and search for 
facts using different search engines. 

1. Click on the  drop down list on the toolbar and select Fact Finder Options. 

You see the Fact Finder Options window displayed (Figure 21-2). 

 
Figure 21-2 Fact Finder Options window 

2. Click on the Add New Entry button. 

You see the first step in the Fact Finder - Add Website wizard. 

3. Complete the wizard to add the ‘Webcrawler’ website (www.webcrawler.com). Make 
sure you add it to the ‘General’ website category. 

4. Click on the  drop down list on the toolbar and point your cursor over Search 
using. You see a drop down list displaying the different categories of search engines 
available. 

5. Point your cursor over General and select the Webcrawler search engine. 

You see the Manual Text Search window displayed (Figure 21-3). 

 
Figure 21-3 Manual Text Search window 
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6. Type A charm of Finches in the text box provided and then click on the OK button. 

Your browser window opens displaying the search results for ‘A charm of Finches’ in 
Webcrawler. 

Exercise 4 Setting up hotkeys 
You can set up hotkeys for each of the buttons on the Read&Write 9 GOLD toolbar or for 
some of the menu options. In this exercise you’ll learn how to set up your own hotkeys. 

1. Click on the  drop down list on the toolbar and select General Options. 

You see the Display tab of the General Options window. Click on the Hotkeys tab 
(Figure 21-4). 

 

HotKey combination
 list box

HotKey function 
list box 

HotKey function 
selection list box HotKey combination

section

Figure 21-4 Hotkeys tab 

2. Select the Evaluate in document option from the HotKey function selection list box. 

3. Select the Control key and the Alt key check boxes in the HotKey combination 
section and then select ‘E’ from the Keyboard keys drop down list. If you click on the 
drop down list and press the E key on your keyboard, ‘E’ will be selected. 

4. Click on the Save button. The entry is listed in the HotKey combination and HotKey 
function list boxes. 

5. Select the Speak current option from the HotKey function selection list box. 

6. Select both the Control key and Alt key check boxes and then select ‘S’ from the 
Keyboard keys drop down list. 

7. Click on the Save button. 

The entry is listed in the HotKey combination and HotKey function list boxes. 

8. Click on the OK button to save your settings and to close the General Options 
window. 

9. Type 766/2 into a Microsoft Word document and then highlight the sum. 
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10. Press the Ctrl Alt and E keys on your keyboard. The sum is evaluated in your 
document and the answer is inserted. 

11. Click anywhere on the sum and then press the Ctrl Alt and S keys on your keyboard. 
You hear the sum read aloud. 

12. Open the Hotkeys tab of the General Options window again and try setting up a few 
of your own hotkeys. 

Exercise 5 Setting up autotext 
You can create short cuts for long pieces of text by giving them an abbreviation. You can 
then type the abbreviation into your document and Read&Write 9 GOLD will automatically 
replace it with the text. In this exercise, you’ll learn how to set up your own abbreviations. 

1. Click on the  drop down list on the toolbar and select General Options. 

2. You see the Display tab of the General Options window. Click on the Autotext tab 
(Figure 21-5). 

 

I would like to use abbreviations
check box

Abbreviation text box 

Representing 
paragraph text box 

Abbreviations list box

Figure 21-5 Autotext tab 

3. Select the I would like to use abbreviations check box. 

4. Type sl in the Abbreviation text box, then type starlight in the Representing 
paragraph text box and then click on the Save button. 

5. Click on the OK button to save the new setting and to close the General Options 
window. 

6. Type sl into your Microsoft Word document and then press Enter on your keyboard. 

Note how the system automatically replaces the letters, ‘sl’, with the word ‘starlight’. 

7. Open the Autotext tab of the General Options window again and try setting up a few 
of your own abbreviations. 
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Exercise 6 Loading your personal settings 
In this exercise you’ll learn how to save your personal settings to a memory stick and take 
them home. You can then load your personal settings from the memory stick at home. 

 It is possible to save your personal settings to a location of your choice, for example, 
on your hard drive. However, in this exercise, you are required to save them to a 
memory stick. 

1. Click on the  drop down list and select Save my settings. 

To load your personal settings at another location: 

2. Insert your USB drive into your USB port. 

3. Click on the  drop down list and select Load my settings. 

The Browse For Folder window is displayed. 

4. Browse for the USB drive on your computer and then click on the OK button to load 
your personal settings. 
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22. USING THE TEACHER’S TOOLKIT 

In this section you’ll learn how to use the Teachers Toolkit to: 

• set up feature sets 

• set up new users and assign them feature sets 

• add a new prediction file 

• add dictionary definitions 

• view users spelling logs 

• view users activity logs 

• import users. 

 In order to complete these exercises you must have the Teachers Toolkit installed on 
your computer. 

 You can also use the Teacher’s Toolkit to change how words are pronounced by the 
system using the Say Like tab. For information on using the Say Like tab, refer to 
Exercise 5 ‘Changing how words are pronounced’ on page 11. 

To access the Teachers Toolkit, click on Start on the Windows desktop. Select All 
Programs, Texthelp Systems, then Read&Write 9 and then Teacher’s Toolkit, as shown 
below: 

 
Figure 22-1 Teachers Toolkit Menu 

You see the User Settings tab of the Read and Write Teacher’s Toolkit window (Figure 
22-4). 

Exercise 1 Setting up feature sets 
You can set up feature sets and then assign them to users. These feature sets determine 
which Read&Write 9 GOLD features will be available to each student.  
Let us start by setting up a feature set that’ll allow you to use all of the Read&Write 9 
GOLD facilities.  

1. Click on the Feature Sets tab (Figure 22-2).  
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New button 

Save button 

Current Feature Set
check boxes Enable Options 

Dialogs check boxes 

Figure 22-2 Feature Sets tab 

2. Click on the New button. You see the New Feature Set window (Figure 22-3). 

 
Figure 22-3 New Feature Set window 

3. Type No Options in the text box provided and then click on the OK button. 

All of the Current Feature Set check boxes and the Enable Options Dialogs check 
boxes are selected automatically when you add a new feature set. 

4. De-select all of the Enable Options Dialogs check boxes to specify that you don’t 
want users with this feature set to have access to any of the Read&Write 9 GOLD 
Options windows. 

5. Click on the Save button. You’ve now set up a new feature set which will allow you to 
access all of the Read&Write 9 GOLD facilities but none of the Options windows. 
Users with this feature set will therefore be unable to alter any of the default settings.  

Now you need to make sure that the feature set is applied to the appropriate users. 
Complete the next exercise. 

Exercise 2 Setting up new users and assigning feature sets 
When you add a new user you should assign them to a user group. This makes it easier 
to manage their account. Once you have done this you can assign a feature set to them.  

Use the instructions below to create a new user group, assign a new user to this group 
and then apply the feature set you’ve just set up. 

1. Click on the User Settings tab (Figure 22-4). 
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New button in 
Groups section Groups list box

New button in User 
Management section

Users in the current Group
 list box

Figure 22-4 User Settings tab 

2. Click on the New button in the Groups section of the tab. You see the Create New 
User Group window (Figure 22-5). 

 
Figure 22-5 Create New User Group window 

3. Type the text Class 1A in the text box provided and then click on the OK button. This 
user group is now listed in the Groups list box. 

4. Click on the New button in the User Management section of the tab. You see the 
Create a new User account window (Figure 22-6). 

 

User logs on to windows
using a shared login

 radio button

Enter a login for the 
new User text box 

Enter a Password 
for the User text box

Select a Feature Set 
for the User drop 
down list 

Select a Group for the 
User drop down list 

Figure 22-6 Create a new User account window 
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5. Select the User logs on to windows using a shared login radio button. 

6. Type the word Me in the Enter a login for the new User text box. 

7. Type the text firsttime in the Enter a Password for the User text box.  

8. Select No Options from the Select a Feature Set for the User drop down list. 

9. Select the Class 1A option from the Select a Group for the User drop down list. 

10. Click on the Create button. You have now added your user account, assigned it to the 
Class 1A user group and applied the ‘All Features’ feature set to it.  

It’s easy to change the user group or feature set to which your user account is assigned, 
by simply selecting your user account check box in the User in the current Group list 
box and selecting a different user group/feature set from the Feature Sets and User 
Groups section of the tab. 

Exercise 3 Adding a new prediction file 
In this exercise you’ll learn how to add a new prediction file which can then be used by the 
Prediction facility to learn new words and phrases. You’ll then specify to which user 
accounts you want to make this new prediction file available. 

Before you begin this exercise, make sure you have a text file containing a 
comprehensive list of words and phrases, saved on your computer. 

1. Click on the Prediction tab (Figure 22-7). 

 

Create and distribute 
Prediction Files list box  Groups list box

Add File to Build 
list button 

Users in the current
Group list box File Description 

text box  

File Name text box 

Learn files into new 
prediction file and copy 
to checked users button 

Turn On/Off Prediction 
Files button 

Figure 22-7 Prediction tab 

2. Click on the Add File to Build list button. 

The Open window is displayed. 

3. Browse to the location in the directory where the text file you want to add is located 
and then click on the Open button.  

The name of the text file is added to the Create and distribute Prediction Files list 
box. 
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4. Type Prediction test in the File Description text box. 

5. Type Test Prediction file in the File Name text box. 

6. Select the Check words as they are learned check box. This will ensure that the 
text in the text file will be spell checked before it is added to the Prediction file. 

 If you want to create a prediction file with very specialized terms and/or jargon you 
should keep the Check words as they are learned switched off. 

 
7. Click on the Class 1A user group in the Groups list box. 

8. Select the Me check box in the Users in the current Group list box. 

9. Click on the Learn files into new prediction file and copy to checked users 
button.  

The words and phrases in this text file will now be used by the Prediction facility to provide 
the specified user account with a list of possible words and phrases with which they can 
finish sentences as they type. 

 You can enable and disable prediction files for different users by clicking on the Turn 
On/Off Prediction Files button and selecting the appropriate check boxes. 

Exercise 4 Adding your own dictionary definitions 
In this exercise you’ll learn how to add your own dictionary definitions.  

 Any new definitions that you add will be added to current definitions and will be 
applied to all user accounts. 

1. Click on the Dictionary tab (Figure 22-8). 

 

Enter a new 
Dictionary 

Word text box Add word to custom 
spelling dictionary 
check box 

Enter Definition text 
box Enter Synonym  

text box 

Add to Synonym list button

Save button 

Figure 22-8 Dictionary tab 

2. Type Discombobulate in the Enter a new Dictionary Word text box. 
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3. Select the Add word to custom spelling dictionary check box. 

4. Type the following text in the Enter Definition text box: 

Throw into state of confusion 
5. Type upset in the Enter Synonym text box and then click on the Add to Synonym 

list button. 

6. Click on the Save button and then click on the Yes button when it asks you if you 
want to add the entered information as an additional definition. 

Exercise 5 Viewing a user’s spelling log 
To view a user's spelling log: 

1. Click on the Spelling Logs tab (Figure 22-9). 

 

Groups list box

Users in the current Group
 list box

View checked logs 
in Word button 

Figure 22-9 Spelling Logs tab 

2. Click on the Class 1A user group in the Groups list box. 

3. Select the Me check box in the Users in the current Group list box. 

You see a list of spelling errors you’ve made while using the ‘Me’ profile in the panel 
on the right of the Spelling Logs tab. 

4. Click on the View checked logs in Word button. 

Microsoft Word launches and you see your spelling log displayed in a new document. 

Exercise 6 Viewing a user’s activity log 
To view a user's activity log: 

1. Click on the Activity Logs tab (Figure 22-10). 
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Groups list box

Users in the current Group
list box

View checked logs 
in Word button 

Figure 22-10 Activity Logs tab 

2. Click on the Class 1A user group in the Groups list box. 

3. Select the Me check box in the Users in the current Group list box. 

You see the following information relating to your activities on the system in the panel 
on the right of the Activity Logs tab: 

• Log In - time and date at which you logged on 

• Duration - duration of time spent on the system 

• Typed - number of words typed during each period 

• %Errors - percentage of errors made during each period 

• Learned Words - number of words learned during each period. 

4. Click on the View checked logs in Word button. 

Microsoft Word launches and you see your activity log displayed in a new document. 

Exercise 7 Importing users 
The Teachers Toolkit allows you to import users with roaming profiles or from Read&Write 
7 GOLD. In this exercise, you’ll learn how to import users directly from a CSV file. 

 To complete this exercise, you must have a CSV file containing users saved on your 
computer. 

1. Click on the Import Users tab (Figure 22-11). 
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Run CSV File Import button

Figure 22-11 Import Users tab 

2. Click on the Run CSV File Import button. 

You see a window which allows you to browse for the file. 

3. Select the CSV file that you want to import and then click on the Open button. 

The User Import Summary window is displayed. This shows the users who were 
successfully imported and those who failed to import. The reason for the import failure, if 
any, is also displayed. 

The successfully imported users are added to the 'Default' user group and assigned the 
'Default' feature set. 
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23. USING THE PDF ACCESSIBILITY EDITOR 

In this section you’ll learn how to use the PDF Accessibility Editor to: 

• check how your PDF document is read by PDFaloud  

• alter how the PDF document is read by sentence and paragraph 

• have PDFaloud read Alternative text for an image  

• alter the order that the PDF document is read 

• alter how PDFaloud reads a word 

• create a Lexiflow book. 

 In order to complete these exercises you must have PDF Accessibility Editor 
installed. PDF Accessibility Editor is available on the Read&Write GOLD Tools DVD. 
You should also have the PDF Sample document. This can be located on the 
Presentation and Training DVD/Sample Documents folder or downloaded from 
www.texthelp.com/support/documents. It is recommended that you save this PDF 
document to its own folder on your computer. 

PDF documents are increasingly being used by Publishers, Governments and Educational 
bodies to make information available via the Internet. Read&Write 9 GOLD incorporates 
PDFaloud in order to provide speech support for these documents. Due to the format of 
PDF documents there can sometimes be problems with how accessibility software reads 
them. PDF Accessibility Editor provides the tools in order to have PDF documents read in 
exactly the way you want. 

Exercise 1 Check how your PDF document is read 

1. Click on the  button on the toolbar and open the Sample PDF file when prompted 
by the system. 

The Texthelp PDF Viewer opens and the PDFaloud toolbar is displayed (Figure 23-1).  

 

 
 

 

 

Figure 23-1 PDFaloud toolbar 

Click-and-speak options 
button 

Click-and-
Speak button

Speech buttons
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2. Click on the  button on the toolbar. PDFaloud starts to read aloud the Sample 
PDF document. 

3. You will notice that it reads the date and then the text. It doesn’t always read from the 
correct position and it also pronounces some words incorrectly.  

4. You are going to use PDF Accessibility Editor to make the document read exactly the 
way you want it to. 

Exercise 2 Changing how the document reads paragraphs and 
sentences  

1. Click on Start on the Windows desktop. Select Programs, Read&Write 9, then 
Accessibility Editor, as shown below: 

 
Figure 23-2 Accessibility Editor Menu 

Alternatively, you can double click on the Accessibility Editor shortcut on your 
Desktop. 

The PDF Accessibility Editor Toolbar is displayed (Figure 23-3). 

 
Figure 23-3 PDF Accessibility Editor Toolbar 

2. Click on the  button. Your document will look like this: 
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Figure 23-4 Flow illustration 

3. A blue arrow  indicates the end of sentence, i.e. where there is a full stop. 

4. A green arrow  indicates the start of each paragraph. 

5. How the PDF document is divided into sentences and paragraphs will dictate the 
pace at which the document is read. There is a smaller break in speech between 
sentences than there is between paragraphs. 

 You can change the colors used to indicate sentences and paragraphs in the 

Publishing Options in the  drop down list.  

In the table you may have noticed that the numbers are not being read out with the 
text in that row. It is highlighting the text and the number below. 

6. Click on the  drop down list. The Main Document flow should be 
selected (it will have a check beside it).  
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7. Select  so that it will be switched on. Now the icon will look 

like this  or if you click on the  drop down list you 

will see a check beside Paragraphs .  

Currently the table looks like this: 

 
Figure 23-5 Paragraph flow (1) 

8. Click on each of the green arrows , which appear at the beginning of the text in each 
row. This will remove them. It should now look like this: 

 
Figure 23-6 Paragraph flow (2) 

9. Now click on each number starting from 2. Until it looks like this: 
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Figure 23-7 Paragraph flow (3) 

10. To see the effect of this change click on the  button and then on each of the 
rows. 

You will notice that the bullet points are not being read correctly. The numbers are not 
being read with the line of text. We are going to set each bullet point to read the 
number and then the relevant text. 

11. Click on the  drop down list.  

12. Select  so that it will be switched on. Now the icon will look 

like this  and if you click on the  drop down list you 

will see a check beside Sentences: .  

 

Currently the bullet points look like this: 

 
Figure 23-8 Sentence flow (1) 

13. Click on each of the blue arrows  which appear after the numbers of the bullet 
points. This removes the green arrows so the bullet points look like this: 
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Figure 23-9 Sentence flow (2) 

14. To see the effect of this change click on the  button and then on the first bullet 
point. 

Exercise 3 Have Alternative text for an image 
There are a number of images in the PDF document. Currently PDFaloud does not read 
anything for these. We are going to set up alternative text for each of the images. 

The first image we are going to work on is the image of the PDF Accessibility Editor 
toolbar.  

1. Click on the  button. When you put the cursor over the PDF document it 

will appear like this   

2. Click and hold down the left button on your mouse so that it draws a box round the 

 icon in the picture of the toolbar.  

When you release the button, the Alt text dialog box is displayed (Figure 23-10). 
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Figure 23-10 Alt text dialog box 

3. Type in Flow. 

4. Repeat steps 2-4 for each of the icons on the toolbar so you have – Flow, Auto Flow, 
Alt Text, Word Pronunciations and Options. 

5. Set up alternative text for the  image. 

6. To see the effect of this change click on the  button and then click on each of 
the icons and the Adobe image. 

Exercise 4 Altering how PDFaloud reads a word  
You may have noticed that when PDFaloud reads the date at the top of the document, it 
pronounced it as zero seven slash zero eight slash two thousand and six. Also anytime 
that it reads the word toolbar it does not sound clear. With the PDF Accessibility Editor 
you can change how these are read. To change how something is read in one instance in 
a document you use the Word Pronunciation. To change how something is read 
throughout the document you use the PDFaloud Global Pronunciation Option. 

1. Select  and then click on the 07. 

The Pronunciation panel is displayed (Figure 23-11). 
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Figure 23-11 Pronunciation dialog box 

2. Type in the seventh. Click on then OK. By clicking on Test you can 
easily check how the selection will be pronounced with the change you have made. 

3. Click on the 08 and when the Pronunciation Panel appears type of August. Click on 

. 

4. To see the effect of this change click on the  button and then click on the date. It 
is now read out as The Seventh of August Two Thousand and Six.  

5. In order to complete these exercises you should have the PDF Sample document.  

• You may find some years are pronounced incorrectly. For example, 2007 instead 
of being pronounced two thousand and seven might be pronounced two zero 

zero seven. If this is the case you can use the option. 

• Where acronyms are used e.g. BBC, TUC, ITN etc. you may find that is tries to 

pronounce it as a word. In this case you can use the  option. 

• If you find the selection is following on too quickly to the next word you can add a 

pause after the selection using the  option. 

• If you find the selection is being read too quickly after the previous word you can 

add a pause before the selection by using the  option. 

• In certain cases you may find that a word is being broken up into 2 sections. In 

this case you select the first section and click on the  check 
box. 
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Where you want to change how a word is read throughout the document you can use 
the PDFaloud Global Pronunciation Options. 

6. Click on the  drop box and select . 

The PDFaloud Global Pronunciation Options panel is displayed (Figure 23-12). 

 
Figure 23-12 PDFaloud Global Pronunciation Options dialog box 

7. Type toolbar in the Pronounce this word text box. Click on Speak button to hear 
how it is currently read.  

8. Type tool bar in the Like this text box. Click on the Speak button to hear how it will 
sound. 

9. Click on the Add button and then OK. 

10. To see the effect of this change click on the  button and then click on an 
instance of the word toolbar.  

For some words you may have to type in the phonetic spelling of the word e.g. For Omagh 
type Oma. 

Exercise 5 Altering the order your PDF document is read 
You will have noticed that the PDF document reads the Header before starting to read the 
content and page number. Also, now that we have added Alternative text for the images it 
would be good if they were incorporated. With the PDF Accessibility Editor you can 
change what text is read and in what order it is read. 

1. Click on the  drop down list and select Main document flow as 
shown below: 
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Figure 23-13 Flow (main) drop down list 

2. Click on the  button. 

3. Click on the Date at the head of the page, then the title ‘Texthelp’s PDF Accessibility 
Editor’, followed by the first paragraph. 

Your PDF will look like this: 

 
Figure 23-14 Main document flow (1) 

4. If you make a mistake, right click at the start of the text you have added incorrectly 
and select Remove. 

5. Continue to add all the other areas of text starting with a green arrow  until your 
PDF looks like this: 
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Figure 23-15 Main document flow (2) 

6. To see the effect of this change click on the  button and then click on the date. 
The PDF will be read in exactly the order you have specified. It doesn’t read out the 
page number at the bottom unless you click on it. 

We are now going to set up another flow to read out the Alt text we made for the 
toolbar. 

7. Click on the  drop down list and select . It 

will now look like this . 

Your PDF will now show all text and alt text which can be included in a separate flow 
from the main document as seen here: 
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Figure 23-16 Main document flow (3) 

8. Click on the Flow, Auto Flow, Alt text, Word Pronunciation and Options so it looks like 
this: 

 

9. To see the effect of this change click on the  button on the Flow in the image of 
the toolbar. 

 

If you require any further help with using PDF Accessibility Editor please refer to the Help. 

This can be accessed by clicking on  drop down and selecting Help: 
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Exercise 6 Creating a Lexiflow book 
In this exercise you’ll learn how to create a Lexiflow book from a PDF that has been 
scanned using Read&Write 9 GOLD. 

Lexiflow is a secure and affordable solution to publish accessible, digital talking books for 
students who require extra assistance with their reading. It enables teachers to create 
talking Flash versions of books, to meet the increasing demand from schools for 
accessible books and textbooks.  

PDF Accessibility Editor tools can be used by teachers to ensure that the Lexiflow books 
will be read in the in the way that they want. Students experience the exact representation 
of the original book and can read Lexiflow books on PCs or Macs with Flash installed. 
Dictionary, Translator, Sticky Notes, and Study Skills tools are also available in Lexiflow 
books. 

 The ability to create Lexiflow books is not available to users of Adobe Reader. It is 
only available to users of Adobe Acrobat Standard or Professional. 

1. Open PDF Accessibility Editor.  

2. Open a PDF which you have scanned and saved using Read&Write 9 GOLD. 

3. Click on the  button on the PDF Aloud toolbar. 

You will see the Browse for Folder window displayed. 

4. Locate the folder in which you want to save the Lexiflow book and then click on the 
OK button. 

The Lexiflow book is created and displayed. The system automatically saves it in a 
new folder within the one you have just selected. The new folder is given the same 
name as the PDF file you opened. 

5. Close Adobe Acrobat. 

Locate the folder in which you saved the Lexiflow book and then double-click on the 
toolbar.exe file. 
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